REN ESAS Application Note

Renesas RA Family

RAG6 Basic Secure Bootloader Using MCUboot and
Internal Code Flash

Introduction

MCUDboot is a secure bootloader for 32-bit MCUs. It defines a common infrastructure for the bootloader,
defines system flash layout on microcontroller systems, and provides a secure bootloader that enables easy
software update. MCUboot is independent of operating system and hardware and relies on hardware porting
layers from the operating system it works with. The Renesas Flexible Software Package (FSP) integrates an
MCUboot port starting from FSP v3.0.0. Users can benefit from using the FSP MCUboot Module to create a
Root of Trust (RoT) for the system and perform secure booting and fail-safe application updates.

MCUboot is maintained by Linaro in the GitHub mcu-tools page https://github.com/mcu-tools/mcuboot. There
is a \docs folder that holds the documentation for MCUboot in .md file format. This application note refers to
the above-mentioned documents wherever possible and is intended to provide additional information that is
related to using the MCUboot Module with Renesas RA FSP v3.0.0 or later.

This application note guides you through application project creation using the MCUboot Module on Renesas
EK-RA6M4 and EK-RA6M3 kits for the internal flash usage using FSP v5.5.0. Example projects for the use
case of designing with TrustZone® for multi-image support are provided for EK-RA6M4 internal flash.
Example projects for the use case of designing with single-image support are provided for EK-RA6M3
internal flash. The MCUboot Module is supported across the entire RA MCU Family. Guidelines of how to
adapt the example project configurations for other RA Family MCUs are provided.

Required Resources
Development tools and software

e The e? studio IDE v2024-07

e Renesas Flexible Software Package (FSP) v5.5.0

e SEGGER J-link® USB driver JLink_V798b

Note: The above three software components are bundled in a downloadable platform installer available on
the FSP webpage at renesas.com/ra/fsp.

e Python v3.9 or later (https://www.python.org/downloads/)

Hardware

o EK-RA6M4 Evaluation Kit for RA6M4 MCU Group (http://www.renesas.com/ra/ek-raém4)
o EK-RA6M3 Evaluation Kit for RA6M3 MCU Group (http://www.renesas.com/ra/ek-rabm3)
e Workstation running Windows® 10 and Tera Term console or similar application

e One USB device cable (type-A male to micro-B male)

Prerequisites and Intended Audience

This application note assumes that you have some experience with the Renesas e? studio IDE and Arm®
TrustZone-based development models with e? studio. You also need to understand the device lifecycle
management of Renesas RA TrustZone-based MCU groups. This knowledge can be acquired by reading the
HW User’'s Manual section “Security Features” and Renesas Application Project R11AN0469. In addition,
you should read the entire MCUboot Port section of the FSP User's Manual prior to moving forward with this
application project. This application project also assumes that you have some knowledge of cryptography.

The intended audience includes product developers, product manufacturers, product support, and end users
who are involved with designing application systems involving the use of a secure bootloader.
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1. Overview of MCUboot

1.1 History of MCUboot
MCUboot evolved out of the Apache Mynewt bootloader, which was created by runtime.io. MCUboot was
then acquired by JuulLabs in November 2018. The MCUboot github repo was later migrated from JuulLabs

to the mcu-tools github project. In 2020, MCUboot was moved under the Linaro Community Project
umbrella as an open-source project.

1.2 MCUDboot Functionalities Overview

MCUBoot handles the firmware authenticity check after startup and the firmware switch stage of the firmware
update process. Downloading the new version of the firmware is out-of-scope for MCUboot. Typically,
downloading the new version of the firmware is functionality that is provided by the application project itself.

1.2.1 Validate Application before Booting and Updating

For applications using MCUboot, the MCU memory is separated into MCUboot, Primary App, Secondary
App, and the Scratch Area. Figure 1 is an example of the single-image MCUboot memory map. For more
information on the MCUboot memory layout, refer to the Flash Map section of the MCUboot website.

Scratch Area

Secondary App

Primary App

MCUboot

Figure 1. Single Image MCUboot Memory Flash Map
The functionality of the MCUboot during booting and updating follows the process below:

The bootloader is started when the CPU is released from reset. For TrustZone-based MCUs, MCUboot is
designed to run in secure mode with all access privileges available to it. If there are images in the Secondary
App memory marked as to be updated, the bootloader performs the following actions:

1. The bootloader authenticates the Secondary App image.

2. Upon successful authentication, the bootloader switches to the new image based on the update method
selected. Available update methods are introduced in section 1.2.2.

3. The bootloader boots the new image.

If there is no new image in the Secondary App memory region, the bootloader authenticates the Primary
applications and boots the Primary image.

The authentication of the application is configurable in terms of the authentication methods and whether the
authentication is to be performed with MCUboot. If authentication is to be performed, the available methods
are RSA or ECDSA. The firmware image is authenticated by hash (SHA-256) and digital signature validation.
The public key used for digital signature validation can be built into the bootloader image or provisioned into
the MCU during manufacturing. In the examples included in this application project, the public key is built into
the bootloader images.

There is a signing tool included with MCUboot: imgtool . py. This tool provides services for creating Root
keys, key management, and signing and packaging an image with version controls. Read the MCUboot
documentation to use and understand these operations.

1.2.2 Applications Update Strategies

The following are the update strategies supported by MCUboot. The analysis of pros and cons is based on
the MCUboot functionality, but not the FSP MCUboot Module functionality. In addition, this application note is
not intended to provide all details on the MCUboot application update strategies. We recommend acquiring
more details on these update strategies by referring to the MCUboot design page:

https://github.com/mcu-tools/mcuboot/blob/master/docs/design.md

R11AN0497EU0140 Rev.1.40 Page 4 of 49
Oct.10.24 RENESAS


https://github.com/mcu-tools/mcuboot
https://docs.mcuboot.com/design.html#flash-map
https://github.com/mcu-tools/mcuboot/blob/master/docs/imgtool.md
https://github.com/mcu-tools/mcuboot/blob/master/docs/design.md

Renesas RA Family RA6 Basic Secure Bootloader Using MCUboot and Internal Code
Flash

e Overwrite

In the Overwrite update mode, the active firmware image is always executed from the Primary slot, and
the Secondary slot is a staging area for new images. Before the new firmware image is executed, the
entire contents of the Primary slot are overwritten with the contents of the Secondary slot (the new
firmware image).
e Pros

o Fail-safe and resistant to power-cut failures.

e Less memory overhead, with a smaller MCUboot trailer and no Scratch Area.

e Encrypted image support is available when using external flash.
e Cons

e Does not support pre-testing of the new image prior to overwriting.

o Does not support automatic application fallback mechanism.
Overwrite upgrade mode is supported by Renesas RA FSP v3.0.0 or later. External flash memory
support is supported by FSP v3.5.0 or later. The overwrite update mode is demonstrated in sections 3.3
and 3.7.

e Swap

In the Swap image upgrade mode, the active image is also stored in the Primary slot and is always
started by the bootloader. If the bootloader finds a valid image in the Secondary slot that is marked for
upgrade, then contents of the Primary slot and the Secondary slot are swapped. The new image then
starts from the Primary slot. Upgrading an old image with a new one by swapping can be a two-step
process. In this process, MCUboot performs a “test” swap of image data in flash and boots the new
image. The new image can then update the contents of flash at runtime to mark itself “OK”, and
MCUDboot will then still choose to run it during the next boot.
e Pros

e The bootloader can revert the swapping as a fallback mechanism to recover the previous

working firmware version after a faulty update.

e The application can perform a self-test to mark itself permanent.

e This image upgrade mode is fail-safe and resistant to power-cut failures.

o Encrypted image support is available when using external flash.
e Cons

o Need to allocate a Scratch Area.

e Larger memory overhead, due to a larger image trailer and additional Scratch Area.

e Larger number of write cycles in the Scratch Area, thus faster wearing out of Scratch sectors.

Swap upgrade mode is supported by Renesas RA FSP v3.0.0 or later. Runtime image testing is
supported by FSP v3.4.0 or later, excluding v3.5.0. External flash memory support is supported by FSP
v3.5.0 or later. The swap update mode without test mode is demonstrated in section 3.4 and the swap
update mode with test mode is demonstrated in section 3.8.

e Direct execute-in-place (DXIP)
In the direct execute-in-place mode, the active image slot alternates with each firmware update. If this
update method is used, then two firmware update images must be generated: one of them is linked to be
executed from the Primary slot memory region, and the other is linked to be executed from the
Secondary slot.
e Pros
e Faster boot time, as there is no overwrite or swap of application images needed.
o Fail-safe and resistant to power-cut failures.
e Cons
e Added application-level complexity to determine which firmware image needs to be downloaded.
o Encrypted image support is not available.

Direct execute-in-place mode is enabled in FSP for the code flash linear mode as well as code flash dual
bank mode. The DXIP update mode is demonstrated in section 3.5.
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¢ RAM loading firmware update
Like the direct-XIP mode, RAM loading firmware update mode selects the newest image by reading the
image version numbers in the image headers. However, instead of executing it in place, the newest
image is copied to RAM for execution. The load address (the location in RAM where the image is copied
to) is stored in the image header. This upgrade method is not typically used in an MCU environment.
Refer to the RAM Loading section in the MCUboot page for more information on this update strategy.
This image update mode does not support encrypted images (see MCUboot documentation on
encrypted image operation).
RAM loading update mode is not supported by the Renesas RA FSP.

2. Architecting an Application with MCUboot Module using FSP

This section provides an overview of the FSP MCUboot Module, which integrates MCUboot as a module into
the FSP. The available upgrade modes and memory architecture design are discussed. In addition, signing
and mastering new images are discussed.

2.1 MCU Memory Configuration using MCUboot Module with FSP

For single-image projects, refer to Figure 1 from section 1.2.1 to see the default memory map layout. For
applications with two separately updateable images, such as TrustZone® applications where the Secure and
Non-Secure images can be updated separately, the default memory map layout is shown in Figure 2.

32?0"%” Secondary Non-Secure App

*—  Non-secure
Zg{”aw Primary Non-Secure App

A]H NSC

Primary Primary Secure App )
slot
Secondary Secondary Secure App
slot

*—  Secure

Scratch Area
MCUboot

Figure 2. Two-Image MCUboot Module Memory Map (TrustZone)

2.2 Overview of FSP MCUboot Module

This section provides a high-level overview of the MCUboot Module in the FSP. Currently, the FSP supports
four firmware update methods:

e Overwrite Only: The entire Primary slot is overwritten with the Secondary slot.

o Overwrite Only Fast: Only sizeof(secondary_image) is copied into Primary slot. Unused sectors are not
copied.

e Swap: The entire Primary and Secondary slots are swapped. A Scratch region is required.

e Direct XIP: The new image is run directly from its flash partition.

We recommend reviewing MCUboot port section of the FSP User’'s Manual to understand the Build Time
Configurations for MCUboot. This section is not meant to cover all the configurable properties. Only some of
the most frequently used configuration options are introduced.
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2.21 General Configuration
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Custom mcuboot_config.h

Upgrade Mode Overwrite Only
Validate Primary Image Enabled
Downgrade Prevention (Overwrite Only) Disabled

Number of Images Per Application 2 (TrustZone)

Figure 3. FSP MCUboot Module General Configuration Properties
General configuration properties include:

e Custom mcuboot_config.h: The default mcuboot config.h file contains the MCUboot Module
configuration that you selected from the RA configurator. You can create a custom version of this file to
achieve additional bootloader functionalities available in MCUboot.

e Upgrade Mode: This property configures the application image update method selection explained at
the beginning of section 2.2. The options are Overwrite Only, Overwrite Only Fast, Swap, and Direct XIP,
as shown in Figure 4. Overwrite Only is the default setting.

Thread % ] Mew Thread HAL/Common Stacks 4] New Stack > =% Extend Stack >
reads .
%] Remove [
v E} HAL/Common &
42 A innnrt /O Part (1 inme ¥
£ >

2] New Cbject »

—

M. | Remove <

Objects

Summary ‘BSP|CIock5|Pins||nterrupts‘Event Links | Stacks Components|

B__E Problems El Console [} Properties Q-Smaﬂ Browser [J:} Smart Manual ﬂ Memory

MCUboot
Settings Property Value
~ Common
APl Info
v General
Custom mcuboot_config.h
Upgrade Mode Overwrite Only
Validate Primary Image Swap
Downgrade Prevention (Overwrite Only) O : O
Number of Images Per Application Overwrite Only Fast
Watchdog Feed Direct Xip
Figure 4. Application Image Update Mode
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Figure 5 is a more detailed application image format that can be referenced to understand the various
MCUboot property definitions.

ScratchArea (swap
upgrade mode only)
__________ Trailer
Secondary f------m--mmomo oo
slot _Type Length Value (TLV)
Application 2
Header «— Image Magic number
Primary | Traler
slot Type Length vValue (TLvy|  'MA98_0k
"""""" T[T Magic number
Application 1
""""" Header
*—Head i b
Bootloade Bootloader FARET MAgIE ALmber

Figure 5. General Configuration for MCUboot Module

e Validate Primary Image:

When Validate Primary Image is enabled, the bootloader performs a hash or signature verification,
depending on the verification method chosen, in addition to the MCUboot sanity check based on the
image header and TLV area magic numbers. The Header and TLV area magic humbers are always
checked as part of the sanity checking prior to the integrity checking and the signature verification.
When Validate Primary Image is disabled, the integrity check based on hash is performed as well as the
sanity check is performed. It is highly recommended to always enable this property if boot time is not a
concern. Note that the image magic number is not part of the image validation; it is a reference value
that can be used for sanity check during application upgrade debugging process. This image magic
number is written to the flash after a successful image upgrade.

o Downgrade Prevention (Overwrite Only): This property applies to Overwrite upgrade mode only.
When this property is enabled, new firmware with a lower version number will not overwrite the existing
application.

e Number of Images Per Application: This property allows you to choose one image for Non-
TrustZone®-based applications and two images for TrustZone-based applications.

2.2.2 Application Image Signature Type Options

Application images using MCUboot must also be signed to work with MCUboot. At a minimum, this involves
adding a hash and an MCUboot-specific constant value in the image trailer.

Figure 6 shows the signature types available for the application image signing methods supported by the
MCUboot module. For memory restricted devices, you can choose None for Signature Type, which will
reduce the bootloader size. For example, the example bootloader for the Overwrite update mode uses a
flash area of 64 KB when using ECDSA P-256 signature type, but when signature support is not used, the
bootloader reduces to about 19 KB.
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Figure 6. Application Image Signature Type for FSP MCUboot Module

2.2.3 Signing Options
Figure 7 shows the default Custom signing option configuration provided by FSP.

~ Signing and Encryption Options

~ TrustZone
Boot Record (Image 2)
| Custom (Image 2) ——confirm |
Signature Type ECDSA P-256
Boot Record
| Custom --confirm |

Figure 7. FSP Default Signing Option

By default, FSP sets --confirm for the Custom property for both Image 1 and Image 2 when TrustZone is
used. For TrustZone-based applications, the Secure Image (Image 1) and Non-Secure Image (Image 2) can
have different configurations such that there is different update policy for the Secure and Non-Secure
Images. Some commonly used signing options are:

e Option --pad:
This option places a trailer on the image that indicates that the image should be considered for an
upgrade. Writing this image in the Secondary slot causes the bootloader to upgrade to it. When Swap
mode is selected, this option generates a signing command such that the Secondary image will first be
swapped with the Primary application image. On the next reset, the Primary application previously used
will be swapped back and rebooted.

e Option --confirm:
When Swap mode is selected, this option generates a signing command such that the Secondary image
will first be swapped with the Primary application. At the next reset, there will be no swap between the
Primary and Secondary application and the Secondary application will be booted. Confirm is the default
Force Upgrade configuration.

e Noinput:
If no option is put in this property, application images signed with the signing command generated from
this setting will not be updated.
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When Overwrite mode is selected, the --pad or --confirm option generates signing commands such that the
overwrite will occur and the Secondary application will overwrite the Primary application.

The image signing tool Imgtool.py is included with MCUboot. It is integrated as a post-build tool in

e? studio to sign the application image. For detailed information about using this tool with e? studio, refer to
the application image signing information in section 5.2. For more information on the possible options
available for this property setting, refer to the description in the imagetool.py md file and visit the MCUboot
documentation page https://docs.mcuboot.com/imgtool.html.

2.2.4 MCU Memory Configuration

Figure 8 shows the default memory configuration options provided by the FSP configurator for RA6 MCU
groups.

~ Flash Layout

v TrustZone
MNon-Secure Callable Region Size (Bytes) Ox0
MNon-Secure Flash Area Size (Bytes) (TrustZone Non-Secure) Ox0
Mon-Secure Callable RAM Region Size (Bytes) Ox0
Mon-Secure RAM Region Size (Bytes) (TrustZone Non-Secure] 0x0
Image 2 Header Size (Bytes) Ox80
Bootloader Flash Area Size (Bytes) 0x20000
Image 1 Header Size (Bytes) O0x80
Image 1 Flash Area Size (Bytes) 0x20000
Scratch Flash Area Size (Bytes) Ox0

Figure 8. MCU Memory Configuration Default Settings
For both single-image and two-image configurations, the following four properties need to be defined:

e Bootloader Flash Area: Size of the flash area allocated for the bootloader.

¢ Image 1 Header Size: Size of the flash area allocated for the application header for single image
configuration or the secure application image header size in the case of a TrustZone®-based application.
This property should be set to 0x200 for RA6 and RA4 MCUs and 0x100 for RA2 MCUs.

o Image 1 Flash Area Size: Size of the flash area allocated for the application image for single image
configuration or the secure application image in the case of a TrustZone-based application.

e Scratch Flash Area Size: This property is only needed for Swap mode. The Scratch area must be large
enough to store the largest sector that is going to be swapped. For both RA6M4 and RA6M3, the
Scratch area is set up to be 32k (0x8000).

The properties under TrustZone drop-down are for TrustZone-based applications:

e Non-Secure Callback Region Size (Bytes): This area is used for the TrustZone Non-Secure Callable
area plus the MCUboot trailer. This property needs to be set to a multiple of 1024 bytes. Each Non-
Secure Callable function takes 8 bytes of flash area. The non-secure callback function usage can be
identified by referring to the section .sgstub in the secure application map file. For Swap mode, the
MCUboot trailer size is calculated as 128*(5+(3*BOOT_MAX_IMG_SECTORS)).
BOOT_MAX_IMG_SECTORS is the number of flash sectors in either the secure or the non-secure
image, whichever is larger.

For Overwrite mode, the image trailer is less than 256 bytes, for a typical application with limited number
of Non-Secure Callable APls, it is recommended to set the Non-Secure Callable Region Size to 0x400.

e Non-Secure Flash Area Size: Size of the Non-Secure flash region. You can compile the non-secure
application to get the size of the image and set this value accordingly. This value must be a multiple of
the flash block size.

e Non-Secure Callable RAM Region: This property is the size of the Non-Secure Callable RAM region of
the Secure image. This property needs to be set to a multiple of 1024 bytes.

e Non-Secure RAM Region Size: Size of the Non-Secure RAM region. This property must be an integer
multiple of 8192 bytes.

¢ Image 2 Header Size: The non-secure application header size. This property should be set up by
following the same rule as explained for the Image 1 Header Size.
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2.3 Designing Bootloader and the Initial Primary Application Overview

A bootloader is typically designed with the initial Primary application. The following are the general guidelines
for designing the bootloader and the initial Primary application:

e Develop the bootloader and analyze the MCU memory resource allocation needed for the bootloader
and the application. The bootloader memory usage is influenced by the application image update mode,
signature type, and whether to validate the Primary Image. The bootloader maintains a memory map of
all the different images shown in Figure 1 and Figure 2.

o Develop the initial Primary application, perform the memory usage analysis, and compare with the
bootloader memory allocation for consistency and adjust as needed.

o Determine the bootloader configurations in terms of image authentication and new image update mode.
This may result in adjustment of the memory allocated definition in the bootloader project.

o Test the bootloader and the initial Primary application.

Most of these design aspects are addressed in the walk-through in section 4.

2.4 General Guidelines using the MCUboot Module Across RA Family MCUs

The MCUboot Module is supported on all RA Family MCUs. The cryptographic support is provided via
MbedTLS Crypto only module and Tiny Crypt module. Both crypto modules are supported on all RA MCUs
either through software or MCU hardware. The MbedTLS Crypto Only module is supported by the MCU
hardware if the corresponding algorithms are supported by the hardware crypto engine, otherwise MbedTLS
software stack will be used. The MbedTLS offers more crypto algorithms, is generally faster and has a larger
memory footprint. On the other hand, the TinyCrypt module offers a smaller number of algorithms. TinyCrypt
module does not support RSA and is slower but has a much smaller memory footprint. Users can consider
disable the image validation of the primary image prior to execution at MCU reset to reduce the boot time.
See explanations on the validation property in section 2.2.1.

Table 1 is the typical cryptographic selection recommendations when using MCUboot with RA MCUs. If
memory footprint is a priority, users can choose the TinyCrypt module over the MbedTLS Crypto Only
module for some of these use cases. To improve the verification speed and reduce boot time when using
Tiny Crypt, users can consider disable image validation to improve verification and boot time performance.

Table 1. Typical Cryptographic Selection Recommendations for RA MCUs

Crypto Stack RA2 No RA2 with RA4E1, RA4T1, RA4E1, RA4T1, RA6M1/M2/M3,
Encryption | Encryption | RA6E1, RAGE2, RAG6E1, RA6E2, RA6T1, RA4AM2/M3,
RA4W1, RA4M1, RA4W1, RA4M1, RA6M4/M5 with or
RA6T2/T3 No RAG6T2/T3 with without Encryption
Encryption Encryption
MbedTLS X X

(Crypto Only)
HW

MbedTLS
(Crypto Only)
SW

TinyCrypt
(HW AES)

TinyCrypt
(SW Only)

For the Renesas RA Cortex®-M33 MCU series internal flash usage, refer to the RA6M4 example projects
demonstrated in this application project.

For the Renesas RA Cortex-M4 MCUs RA6 MCU series internal flash usage, refer to the RA6M3 example
projects demonstrated in this application project.

For the Renesas RA Cortex-M23 MCU series, refer to the RA2E1 example projects demonstrated in the
Secure Bootloader for RA2 MCUs application project (R11AN0516).
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For MCUboot with encryption support, refer to the RA6M4 example projects demonstrated in the Booting
Encrypted Image using MCUboot and QSPI application project (R11AN0567).

2.5 Customize the Bootloader
The following aspects need to be considered when customizing the bootloader in a product design:

e Customize the image validation method.

e Customized method to download the application.

e Use various optimization methods to reduce bootloader and application image size. For example,
compile the bootloader by Optimize size.

2.6 Production Support

2.6.1 Key Provisioning

By default, the public key is embedded in the bootloader code and its hash is added to the image manifest
as a KEYHASH TLV entry. See section 4.1.3 for more details about the public key and private key that are
used for testing purpose. For production support, follow the example shown in key. c to add the public key.
In addition, you must update the private key for application image signing. Refer to Figure 64 and Figure 65
for the private key selection in the signing command.

As an alternative, the bootloader can be made independent of the included test keys by setting the
MCUBOOT HW_ KEY option. In this case, the hash of the public key must be provisioned to the target device
and MCUboot must be able to retrieve the key-hash from there. For this reason, the target must provide a
definition for the boot retrieve public key hash () function that is declared in
boot/bootutil/include/bootutil/sign key.h. The full option for the -public-key-format
imgtool argument is also required in order to add the whole public key (PUBKEY TLV) to the image manifest
instead of its hash (KEYHASH TLV).

During boot, the public key is validated before it is used for signature verification. MCUboot calculates the
hash of the public key from the TLV area and compares it with the key-hash that was retrieved from the
device. This way, MCUboot is independent from the public key(s). The key(s) can be provisioned any time
and by different parties.

2.6.2 Make the Bootloader Immutable for Enhanced Security

For a Cortex®-M33 MCU, refer to section 6.1 to make the bootloader immutable. For a Cortex-M4 MCU, refer
to section 6.2 to make the bootloader immutable.

2.6.3 Advance the Device Lifecycle States Prior to the Deploying the Product to the Field

For a Cortex-M33 MCU, refer to section 6.3 for the device lifecycle management of the MCU. For a Cortex-
M4 MCU, refer to section 6.4 for the device lifecycle management of the MCU.

3. Running the Example Projects

This section provides a walk-through of running the included example projects. To recreate the bootloader
example projects demonstrated in this section, refer to section 4.1 for the Cortex-M33 implementation.

The bootloader projects introduced have similar functionality except that the memory map definition and
application image update mode are different.

Unzip example projects with bootloader.zip and you will see that there are five folders. Each
folder contains example projects for the specific MCU which include bootloader project and example
application projects.
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example_projects_with_bootloader
Name
rabm3_overwrite_with_bootloader
rabm3_swap_test_with_bootloader ]» non- trustzone examples
rabmd4_dxip_with_bootloader flat
rabm4_overwrite_with_bootloader_tz

rabm4_swap_with_bootloader_tz ]_ trustzone examples

Figure 9. Example Projects with Bootloader Support

Set up the Python development environment by following section 3.3 step 3.2. Note that this step only needs
to be performed once.

3.1 Set Up the Hardware

3.1.1 Set up EK-RA6M4
e Jumper setting: J12 is set to pins 2-3 and J15 is closed.

e Connect J10 using a USB micro to B cable from EK-RA6M4 to the development PC to provide power
and debug connection using the on-board debugger.

Once the EK-RA6M4 is powered up, initialize the MCU prior to exercising the bootloader project.

Erase the entire MCU flash and ensure the MCU is in Secure Software Development Device Lifecycle State.
This can be achieved using the Renesas Device Partition Manager.

1. Power cycle the board, launch e? studio, and open the Renesas Device Partition Manager.

i | Run  Renesas Al Window Help

Renesas Debug Tools > I Renesas Device Partition Manager I |

Figure 10. Open Renesas Device Partition Manager
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2. Select Read current device information.

If the DLM state is SSD, NSECSD, or DPL, proceed to step 3. Otherwise, you must switch to a different
kit to continue the rest of the operation. Below is an example of the readout from an RA6M4 MCU that is

in the SSD state.

Current status of the device
LDLM state : Secure Software Development (55D) |
Debug level DBG2
Secure/NSC memory partition size
- Code Flash Secure  (kB)  :191
- Code Flash NSC (kB 1
- DataFlash Secure (kBY 0
- SRAM Secure (kBy :248
- SRAM NSC kBy :0
END of current status of the device.

Disconnecting...
DISCONMNECTED.

Connection : SUCCESSFUL!
Status display : SUCCESSFUL!

Show Command Line

Run

Figure 11. Read the Device Lifecycle States
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3. Select Initialize device back to factory default, choose J-Link as the connection method, and click

Run.

&) Renesas Device Partition Manager [m| X

@ Enter a value for Action and Emulator type

Device Family: |[Renesas RA

Action

Read current device information Change debug state

Set TrustZone secure / non-secure boundari esl Initialize device back to factory defaull

Target MCU connection:
Connection Type: scl v
Emulator Connection: Serial No ~
Serial No/IP Address: |:|
Debugger supply voltage (V): 0

Connection Speed (bps for SCI, Hz for SWD): 9600
Debug state to change to: Secure Software Development
Memory partition sizes

[[] Use Renesas Partition Data file

Code Flash Secure (KB) 191
Code Flash NSC (KB) 1
Data Flash Secure (KB) 0
SRAM Secure (KB) 248

SRAM NSC (KB) 0

Show Command Line Run

@ ey @" Close
4.

Figure 12. Initialize RA6M4 using Renesas Device Partition Manager

The entire flash will be erased if there are not permanently locked down sections. In addition, if the
device is in the NSECSD or DPL state, the RA6M4 will be initialized to the SSD state.

Power cycle the EK-RAB6M4 after successfully initializing the device to the SSD state by disconnecting
the USB cable and reconnecting it to the development PC.

3.2 Configure the Python Signing Environment

If this is NOT the first time you have used the Python script signing tool on your computer, you can skip this
section. Note that section 3.3 to section 3.8 can be evaluated independently; it is not necessary to follow a
particular sequence.

Download and Install Python v3.9 or later from https://www.python.org/downloads/.

If this is the first time you are using the Python script signing tool on your system, you will need to install the
dependencies required for the script to work:

From the included example project sets (refer to Figure 9), choose the set of projects you would like to
exercise first.

Import that set of projects into a workspace. In this example, we assume you have chosen to import the
projects under folder:
\example projects with bootloader\raém4 overwrite with bootloader tz.

e Navigate to folder \MCUboot in the bootloader project included, for example,
ra mcuboot raémé4>ra>mcu-tools>MCUboot, right click, and select Command Prompt.
Depending on your PC policy, administrator privileges may be required when running the Command
Prompt. This opens a command window with the path set to the \mcu-tools\MCUboot folder.
R11AN0497EUO0140 Rev.1.40 Page 15 of 49
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v =5 ra_mcuboot_ra6m4 [Debug]
il Includes
v (Pra
= arm
(== board
= fsp
¥ [= mcu-tools
(Z ra_gen New ’
2 sre Go Into
(= Debug Open in New Window
(= ra_cfg Show In Alt+Shift+W >
(= script =] Copy Ctrl+C
5k configuratio Paste Ctrl+V
“ RTFAGM4AF #& Delete Delete
- ra_cfg.txt Source ’
X ra_mcuboot, Move...
(@) Developer A Rename... F2
21 Import...
2] Export...
Build Project Ctrl+B
Refresh F5
Index >
Build Targets >
Resource Configurations >
Source >
Team >
2 i Compare With >
@ MCUboot - &* studic Restore from Local Histl open Command Prompt
File Edit Source Refactor Mavigate Search Pr ¥ C/Cr+ Project Settings CUTA+P
| & v 5& A= "b-.h SR <4 % =~ Renesas C/C++ Project Settings >
({5 Project Explorer % BE®Y § = O - % Run C/C++ Code Analysis
e ——— B System Explorer
Tl% app_rabm4_ns_primary ﬁ Command Prompt I
Tlé app_rabm4_ns_secondary 7] Validate
T.é app_raémd_s_primary [Debug]
. Source >
li— app_rabm4_s_secondary
- Properties Alt+Enter

=% ra_mcuboot_rabmé4

Figure 13. Open the Command Prompt

o We recommend upgrading pip prior to installing the dependencies. Enter the following command to

update pip:

python -m pip install --upgrade pip

¢ Note that if you have multiple Python versions installed, make sure to check that the Python version

is version 3.9.0 or later.

e Next, in the command window, enter the following command line to install all the MCUboot

dependencies:

pip3 install --user -r scripts/requirements.txt

This will verify and install any dependencies that are required. Make sure this step runs successfully prior to
moving to the following sections. If your project path contains special characters or spaces, an error may

occur when executing the python script.
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3.3 Running the EK-RA6M4 Overwrite Update Mode Example

Follow the steps below to run the example projects for EK-RA6M4 using the MCUboot Module Overwrite
Only Update mode.

3.3.1 Initialize the RA6M4 MCU

Follow section 3.1.1 to initialize the RA6M4 MCU.

3.3.2 Import the Projects under \ra6m4 overwrite with bootloader tz

New users should refer to the FSP User’s Manual section on Importing Projects into the IDE for guidelines.
Ensure the Python signing environment is set up referencing section 3.2.

0x70000
Secondary
slot Secondary Non-Secure App

0x50000

Primary
1) Project Explorer < slot

Primary Non-Secure App

c . 0x30000
=~ app_rabm4_ns_primary Primary

slot

Primary Secure App
=% app_raébmd4_ns_secondary

1.:(; app,raGm{sfpr\'mary Secondary Secondary Secure App

slot

0x20000

= 0x10000
— app_raém4_s_secondary Scratch Area (size=0)

1% ra_mcuboot_raém4 0x10000

MCUboot

— 0x0

Figure 14. Example Projects for RA6M4 Overwrite Update Mode

e ra mcuboot_raém4: The bootloader project configured with Overwrite update mode.

e app ra6mé4_s primary: The Primary Secure application project with FSP flash driver support with the
flash driver configured as Non-Secure Callable.

e app ra6m4 ns_primary: The Primary Non-Secure application project which calls the Non-Secure
Callable flash driver to erase and write to a code flash region at the top of the code flash area. Upon
successful flash operation, all three LEDs blink.

e app_ra6bmd4_s_ secondary: The Secondary Secure application project with FSP flash driver support
with the flash driver configured as Non-Secure Callable. This application image has the same
functionality as the Primary Secure application, you can use this project as a template to update the
different functionality and exercise the operation of updating the Secure image independent of the Non-
Secure Image update.

e app ra6md4 ns_secondary: The Secondary Non-Secure application project which calls the Non-
Secure Callable flash driver to erase and write to a code flash region at the top of the code flash area.
Upon successful flash operation, only the blue and green LEDs blink.

3.3.3 Compile All the Projects

The bootloader project must be compiled first prior to compiling the application projects. In addition, the
secure project must be compiled first prior to the compiling the corresponding non-secure project. For each
project, open the configuration.xml file, click Generate Project Contents and then click |®! to build the
project. Compile the projects following the order listed below:

1. ra mcuboot ra6m4

2. app ra6tm4 s primary

3. app raom4 ns primary
4. app raébm4 s secondary
5. app_raétm4 ns secondary

For the application projects, the post-build command will also sign the corresponding images. The signed
image for the application project is located under the /Debug folder and is named
<application project name> bin.signed (For example,

/app_ratm4 s primary/Debug/app ratmd4 s primary.bin.signed).
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3.3.4 Debug the Applications and Boot the Primary Applications

Right-click on project app raém4 s primary and select Debug As > Debug Configurations and confirm
the following configuration information:

e The bootloader is downloaded using the .elf format (which includes image and symbol).

e The Primary secure and non-secure images (app_raé6m4 s primary.bin.signed,
app_ra6m4 ns primary.bin.signed) are downloaded using the signed binary as Raw Binary/.

e The Primary secure and non-secure image symbols are included using the .elf files.

& [ = >
L = *| S Name: | app_rabmd_s_primary Debug
|t'r‘0€' filter text | [] Main | %% Debugger | #» Startup| =] Common| %/ Source
't | C/C++ Application Initialization Commands
[€] ¢/C++ Remote Application []Reset and Delay (seconds): | 3
EASE Script
't | GDB Hardware Debugging [ Halt

't | GDB OpenOCD Debugging

't | GDB Simulator Debugging (RH:
1 Java Applet

[T Java Application

& Launch Group Load image and symbols
L?, Remote Java Application

ﬂename Load type Offset (hex) On connect
M ﬁ{ﬁe‘ r;zss;;}:rs:::‘;?n:zrze;:si . Program Binary [app_raém4_s_primary.elf]  Symbols only Yes
= app_rabm4_ns_secondary De ra_mcuboot_rabm4.elf [C\MCUboot\r11a.. Image and Symbols 0 Yes
E app_rabmd._s_primary Debuc app_rabm4_ns_primary.elf [C\A\MCUboot\r.. Symbaols only 0 Yes
= app_rabm4._s_secondary Det app_rabm4_s_primary.bin.signed [CA\MCU.. Raw Binary 20000 Yes
] ra_mcuboot_rabm4 Debug_F app_rabm4_ns_primary.binsigned [C\MC.. Raw Binary 30000 Yes
£ Renesas Simulator Debugging (

Figure 15. Debug Configuration RA6M4 Overwrite
Click Debug.

The debugger should hit the reset handler in the bootloader. Note the address is in the bootloader image.

47 = BSP_SECTION_FLASH_GAP void Reset_Handler (void)
48 {
49 /* Initialize system using BSP. */
2  50]0000aa6c¢ | SystemInit();
51
52 /* Call user application. */
53 0BBBaal2 main();
54
55 0@@Baale while (1)
56 {
t 57 /* Infinite Loop. */
' 58 }
B8 }

Figure 16. Start the Application Execution

Click Resume twice “® and boot the Primary image. All three LEDs should be blinking. Pause the
execution and confirm the execution is in the Non-secure Primary slot.

Click "™ to run again.
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3.3.5 Open the J-Link RTT Viewer
Configure the RTT Viewer as shown below. Set up the search range as: 0x2003e000 0x8000.

H J-Link RTT Viewer V7.98b | Configuration X

Connection to J-Link

) TCRP
O Existing Session

Specify Target Device

| R7FAGMeAF || v

D Force go on connect

Script file (optional)

Target Interface & Speed
SWD v 4000 kHz -

RTT Control Block

O Auto Detection O Address (@ Search Range

Enter one or more address range(s) the RTT Control block can be located in.
Syntax: <RangeStart [Hex]> <RangeSize>[, <RangelStart [Hex]> <RangelSize>, ...]
Example: 0x10000000 0x1000, 0x2000000 0x1000

[ 0x20032000 08000 | |

Cancel

Figure 17. Configure the RTT Viewer

Click OK and observe the output on the RTT Viewer. This repeated output shows the Primary application is
being executed and all three LEDs are blinking.

@2> | Running the Primary non-secure applicaticn with owverwrite update mode.
>

@@> flash write successfull
e as . The Red, Blue and Green LEDs should be blinking.

Figure 18. Execution of Primary Non-Secure Application for Overwrite Mode

3.3.6 Downloading and Running the Secondary Applications

During development, you can use the ancillary loading capability to load the new secure image to the
intended location. You can use the example new secure application provided in this project and follow the
steps below to perform an application upgrade:

1. Press the button to pause the program.

2. On the top of the e? studio toolbar, click the ™ ‘Load Ancillary File button to load the new application
images to the Secondary slot region. Refer to section 3.9 for troubleshooting when using the Load
Ancillary File function.

@ X
Load Ancillary File

Select an ancillary file for loading

le: workspace_loch\app_rabm4_s_secondan\Debugh\app_raém4_s_secondary.binsigne ~ | | Workspace...| | File System...
Fil $lworks| loc om4. dany\Debug), 6m4. dary.bin.signed} Works) File S

Load as raw binary image
Address: Jox10000 |

Cancel

Figure 19. Load the Secondary Secure Application Image for Overwrite Update Mode
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el X
Load Ancillary File

Select an ancillary file for loading

File: ${workspace_loc\app_rabm4_ns_secondary\Debg\app_rabm4_ns_secondary.binsigned} §~ | Workspace...| File System...
P PP ry Pp. ry. el P Y

Load as raw binary image
Address: | 0x50000 ||

Cancel

Figure 20. Load the Secondary Non-Secure Application Image for Overwrite Update Mode

3. Click Resume " . The overwrite occurs and the new image is executed. The blue and green led will be
blinking instead of all three LEDs.

4. On the RTT Viewer output, confirm that the following messages are printed and only the blue and green
LEDs are blinking.

» | Running the Secondary non-secure application with owerwrite update mode.

AP

@@ flash write successfull

Figure 21. Executing the Secondary Non-Secure image for Overwrite Update Mode

3.3.7 Update the Non-Secure Secondary Image

This step is provided as a reference for implementation of individual image update when designing in a
TrustZone environment. The Non-Secure Secondary Image can be updated independent of the Non-Secure
Primary image.

Click Pause again and download the Primary Non-Secure application to the Secondary Non-Secure slot

using the Load Ancillary File & ' tool. Click OK. Click Resume " again. The three LEDs start to blink
again and the RTT Viewer shows the same message as Figure 38.

e For Overwrite update mode, if the Secondary image is marked for update, overwrite always occurs.
e |tis possible to update the Secure and Non-Secure applications individually with proper application

design.
& X
Load Ancillary File
Select an ancillary file for loading
File: |${workspace_loc:\app_ra6m4_n5_primary\Debuqapp_ra6m4_ns_prirnary.binsigned}I V| Workspace... |File System...
oad as raw binary image
Address 0xs0000 |
[ o] o
Figure 22. Load the Primary Non-Secure Image to the Second Slot
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3.4 Running the EK-RA6M4 Swap Update Mode Example without Test Mode

The process of running the EK-RA6M4 Swap Update mode is similar to the Overwrite Update mode. This
section focuses on the difference in the operation:

1. Follow section 3.1.1 to initialize the RA6M4 MCU.
2. Import the project under folder \ra6m4 swap with bootloader tz toa workspace.

0x80000
Seoondary | secondary Non-Secure App
0x60000
Prmary Primary Non-Secure App
0x40000
pnmary Primary Secure App
7 Project Explorer X = <'|Q> 7 8 0x30000
J=% app_raém4_ns_primary ;‘;‘CD”“E'V Secondary Secure App
5-3 app_rabm4_ns_secondary 0x20000
J=% app_raém4 s primary Scratch Area (size=0x8000)
li% app_rabm4_s_secondary P 0x18000
i
%= ra_mcuboot_rabm4: 0

Figure 23. Example Projects for RA6M4 Swap Update Mode

e The bootloader project ra mcuboot raém4 has similar functionality as the bootloader with
Overwrite Update mode introduced in section 3.3 step 3.3.3 except that the memory map definition
and application image update mode are different.

e The functionalities of the application projects are the same as the Overwrite Update mode.

3. Configure the Python Signing Environment by following section 3.2 if this is the first time you are signing
the application image.
4. Compile the example projects in the same order as the Overwrite update mode by referencing section

3.3 step 3.3.3. Ensure the signed image for the application project is located under the /Debug folder and

is named <application project name> bin.signed.

5. Review the Debug Configuration and boot the Primary applications by referencing section 3.3.4.

Q Debug Configurations

Create, manage, and run configurations

‘FeEX| B Y -

type filter text |

Name: | app_rabm4_s_primary Debug

=l Main fS*Debugger = Startup E Source| [ Common

Z++ Application Initialization Commands

~++ Remote Application [[]Reset and Delay (seconds): | 3
SE Script

B Hardware Debugging [ Halt

)B OpenOCD Debugaging
B Simulator Debugging (RH850)

a Applet

ra Application

anch Group Load image and symbols

mote J(;a;zippgcatlon[) b . Filename Load type Offset (hex On connect
nesas ar wjare €bugging Program Binary [app_rabm4_s_primary.elf] Symbols only Yes
app_rabm4_ns_primary Debug_55D

app_rabmé. ns_secondary Debug_SSD ra_mcuboot_rabm4.elf [CAMCUboot\r11.. Image and Symbols 0 Yes
app_raﬁmﬂf_s_érimary Dol - app_rabmd_ns_primary.elf [CA\MCUboot\.. Symbols anly 0 Yes
app_ra6m4_s secondary Debug app_rabm4_s_primary.bin.signed [C\MC.. Raw Binary 30000 Yes
ra_mcuboot_rabm4 Debug_Flat app_rabmd4_ns_primary.binsigned [C\MC.. Raw Binary 40000 Yes

nesas Simulator Debugging (RX, RL78)

Figure 24. Debug Configuration RA6M4 Swap Update Mode
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6. Open the J-Link RTT Viewer and set up the same configuration as Figure 17.
7. Click OK and observe the following output on the RTT Viewer. This output shows the Primary application
is being executed and all three LEDs are blinking.

Running the Primary non-secure application with swap update mode.

flash write successfull
Flash Operation is successful. The Red, Blue and Green LEDs should be blinking.

Running the Primary non-secure application with swap update mode.

flash write successfull
Flash Operation is successful. The Red, Blue and Green LEDs should be blinking.

Figure 25. Execution of Primary Non-Secure Application for Swap Update Mode

3.4.1 Downloading and Running the Secondary Applications

During development, you can use the Ancillary loading capability to load the new Secure image to the
intended location. You can use the example new Secure application provided in this application and follow
the steps below to perform an application upgrade. Refer to section 3.9 for troubleshooting when using the
Load Ancillary File function.

1. Press the button to pause the program.

2. Load the secure new application images to the Secondary slot region using the Ancillary loading

capability "= ' from the top of the e? studio toolbar in a similar way as Figure 19 except use address
0x20000.

3. Load the non-secure new application image to the Secondary slot region using the Ancillary loading
capability " ' from the top of the e? studio toolbar in a similar way as Figure 20 except use address
0x60000.

4. Click Resume Lg . The swap occurs, and the new image is executed. Only the blue and green LEDs
should be blinking.

5. Confirm the execution result.

Running the Seceondary non-secure application with swap update mode.

flash write successfull
Flash Operation is successful. The Elue and Green LEDs should be blinking.

Running the secondary non-secure application with swap update mode.

flash write successfull
Flash Operation successful. The Blue and Green LEDs should be blinking.

Figure 26. Executing the Secondary Non-Secure Image for Swap Update Mode

3.5 Running the EK-RA6M4 DXIP Update Mode Example

The process of running the EK-RA6M4 DXIP Update Modes is similar to the Overwrite Update mode. This
section will focus on the difference in the operation:

1. Follow section 3.3 to initialize the RA6M4 MCU.

2. Import the project under folder \raém4 dxip with bootloader flat to a workspace and see the
following set of example projects.
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0x30000
Scratch Area (size=0x0)
0x30000
Secondary
- slot Secondary App
[{5 Project Explorer X == 0x20000
-t : Primary Primary Aj
i~ app_rabm4_primary; slot v App
T.T(,i app_rabm4_secondary 0x10000
g " MCUboot
li= ra_mcuboot_rabm4_dxip o0
X

Figure 27. Example Projects for RA6M4 Direct XIP Update Mode

The functionalities of the application projects are blinking the LEDs and providing RTT viewer outputs.
3. Configure the Python signing environment by following section 3.2 if this is the first time you are signing
the application image.

4. The bootloader needs to be compiled first. For each project, open the configuration.x1m file, click
Generate Project Contents and then click [®! to build the project. Compile the example projects
following the order below. Ensure the signed image for the application project is located under the
/Debug folder and is named <application project name> bin.signed

1. ra mcuboot raétmé4 dxip
2. app_ra6bm4 primary
3. app_ra6bmé4 secondary

5. Verify the debug configuration and follow section 3.3 step 3.3.4 to start debugging the application.

T e s R | = Name: | app_rabm4_primary Debug_Flat
| type filter text | ['J Main | %% Debugger | Startup| [=] Common | % Source
[c] C/C++ Application Initialization Commands
(€] C/C++ Remote Application [JReset and Delay (seconds): 32
EASE Script
't | GDB Hardware Debugging [1Halt
't | GDB OpenOCD Debugging
'c | GDB Simulator Debugging (RH
¥ Java Applet
[1] Java Application
2 Launch Group Load image and symbols
?’ Remote Java Application Filename Load type Offset (hex)  On connect
Y Créﬂﬁﬁmmﬁm'.l Program Binary [app_raém4_primary.elf] Symbols only Yes
¢ | app_rabm4_primary Debug_ i
ra_mcuboot_rabm4_dxip.elf [C\MCUb.. Image and Symbols 0 Yes
¢ *| app_rabm4_secondary Debu
= ra_mcuboot_ra6m4._dxip Del app_rabm4_primary.bin.signed [C\MC.. Raw Binary 10000 Yes
'c’| Renesas Simulator Debugging

Figure 28. Debug Configuration DXIP Update Mode

6. Open the J-Link RTT Viewer and set up configuration similar as Figure 17 except change the search
range to 0x20000000 0x8000.

7. Click OK and observe the following output on the RTT Viewer. This output shows the Primary application
is being executed and all three LEDs are blinking.

Running the Primary application with DXIP update mode.
The Red, Blue and Green LEDs should be blinking.

Figure 29. Execution of Primary Application for DXIP Update Mode
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3.5.1 Downloading and Running the Secondary Applications
Refer to section 3.9 for trouble shooting when using the Load Ancillary File function.

During development, you can use the Ancillary loading capability & from the top of the e? studio toolbar
to load the new image to the intended location. You can use the example new application provided in this
application and follow the steps below to perform an application upgrade:

1. Press the button to pause the program.

2. Load the new application images to the Secondary slot region using the Ancillary loading (3 capability
from the top of the e? studio toolbar.

e X
Load Ancillary File

Select an ancillary file for loading

File: |${wormpace_loc:\app_ra6m4_sec0ndary\Debug\app_ra6m4_secondary‘bin.signed} ~ | | Workspace... | File System...

Load as raw binary image
Address: | 0x00020000 |

Concel

Figure 30. Load the Secondary Secure Application Image for DXIP Update Mode

3. Click Resume Lg . The swap occurs, and the new image is executed. Only the blue LEDs should be
blinking.

4. Confirm the same configuration as shown in Figure 17, then click OK.

Running tk dary application with DXIP update mode.
The Blue LED 1d be blinking.

Figure 31. Executing the Secondary Image for DXIP Update Mode
3.6 Set up EK-RA6M3

Erase the entire MCU flash prior to proceeding to the following steps. This can be done using J-Link Flash
Lite. Launch J-Flash Lite and select the RA6M3, as shown in Figure 39.

Device Interface

I]R?FASMSAH I WD v | 4000kHz

Figure 32. Open J-Link Flash and Select RA6M3

Click OK and select Erase Chip at the next window.

File  Help
Target
Device Interface speed

[R7Fastzan | [swo | 4000 ke

Data File (bin  hex § mat | srec { ...) Prog. add (in file only)

[ Program Devics

Figure 33. Erase RA6M3

The entire flash will be erased if there are not permanently locked down sections.
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3.7 Running the EK-RA6M3 Overwrite Update Mode Example

Follow the steps below to run the example projects for EK-RA6M3 using the MCUboot Overwrite Only

Update mode.

3.7.1 Import the Projects under Folder \raém3 overwrite with bootloaderto a
Workspace

The following example projects are included in this folder:

0x58000

Scratch Area (size=0x0)
0x58000
Secondary
slot Secondary App
. L, 2
5 Project Explorer X == 0x38000
- $£ . Sgﬂary Primary App
li— app_rabm3_primary
e 6m3 i 0x18000
1‘? app_rabm3_secondary S
J=% ra_mcuboot_rabm3 0x0

Figure 34. Example Projects for RA6M3 Overwrite Update Mode

e Project ra mcuboot ra6m3 is the bootloader project.

e Project app raém3 primary is the initial Primary application project. This project blinks the three
LEDs on the EK-RA6MS3 kit.

e Projectapp ra6m3 secondary is the Secondary application project. This project blinks the blue LED
on the EK-RA6M3 kit.

Follow section 3.2 to set up the Python signing environment if this is the first time you are signing the
application image.

3.7.2 Compile the Projects
The bootloader needs to be compiled first. For each project, open the configuration.xml file, click

Generate Project Contents, and then click to build the project. For the application projects, the post-
build command will also sign the corresponding images. The signed image is located under the \Debug
folder and is named <project name>.bin.signed (for example,

/app_ra6tm3 primary/Debug/app ra6tm3 primary.bin.signed)

1. ra mcuboot ra6m3
2. app_raébm3 primary
3. app_ra6bm3 secondary

3.7.3 Debug the Applications and Boot the Primary Application
Right-click on project app_raém3_primary and select Debug As > Debug Configuration.

& & . 2 o -
L = ¥ ‘ = Name: | app_rabm3_primary Debug_Flat

|T:3"DE'f ter text | =] Main *F Debugger | I Startup [ Common E Source
€] C/C++ Application Initialization Commands
(€] C/C++ Remote Application

[]Reset and Delay (seconds): 3

EASE Script
[JHalt

'C | GDB Hardware Debugging

'c | GDB OpenOCD Debugging

'©*] GDB Simulator Debugging (RH
1 Java Applet

[17 Java Application
& Launch Group Load image and symbols
E, Remote Java Application

—_ Filename Load type Offset (hex)  On connect
v [t] Renesas GDB Hardware Debug: -
= = Program Binary [app_ra.. Symbols only Yes
l c | app_rabm3_primary Dehug_l
= ra_mcuboot_rabm3.elf [.. Image and Symbols 0 Yes.
| app_rabm3_secondary Debu K i i
£ ra_mcuboot_ra6m32 Debug._F app_rabm3_primary.bin... Raw Binary 18000 Yes

] Renesas Simulator Debugging |

Figure 35. Debug Configuration RA6M3 Overwrite Update
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Click Debug.

The debugger should be at the reset handler in the bootloader. Note the address is in the bootloader image.

w [&] app_rabm3_primary Debug_Flat [Renesas GDB Hardware Debugc
4 ‘ app_rabm3_primary.elf [1] [cores: 0]
v o Thread #1 1 (single core) [core: 0] (Suspended : Signal : SIG

= Reset_Handler() at startup.c:50 Oxcb90

® * MCU starts executing here out of reset. Main stack pointer is set up already.[
= BSP_SECTION_FLASH_GAP void Reset_Handler (void)

/* Initialize system using BSP. */

SystemInit();

= Oxfffffffe
4 arm-none-eabi-gdb (12.1) /* Call user application. */
» Renesas GDB server (Host) 00cb96 main();

Figure 36. Start the RA6M3 Application Execution

Click Resume twice “* and boot the Primary image. All three LEDs should be blinking.

3.7.4 Open the J-Link RTT Viewer
Configure the RTT Viewer as shown below. Configure the address search range as 0x1ffe0000 0x8000.

H J-Link RTT Viewer V7.98b | Configuration X

Connection to J-Link

[7] serial No
O TCrP
O Existing Session

Specify Target Device

|R?FA6M3AH I v|| I

|:| Force go on connect

Script file (optional)

Target Interface & Speed
SWD v | 4000 kHz ~

RTT Control Block ;
() Auto Detection () Address (@) Search Range

|
Enter one or more address range(s) the RTT Control block can be located in.

Syntax: <RangeStart [Hex]> <RangeSize>[, <RangelStart [Hex]> <RangelSize>, ...]
Example: 0x10000000 0x1000, 0x2000000 0x1000

J oxtffenono oxsooo | |

Figure 37. Configure the RTT Viewer for RA6M3 Project

Click OK and observe the following output on the RTT Viewer. This output shows the Primary application is
being executed and all three LEDs are blinking.

=
=]
e

Running the Primary application with overwrite update mode.
The Red, Blue and Green LEDs sheuld be blinking.

=]
=]
W W

Running the Primary application with overwrite update mode.
The Red, Blue and Green LEDs should be blinking.

a
a
a

o

Figure 38. Execution of Primary Application for Overwrite Mode

3.7.5 Downloading and Running the Secondary Applications

During development, you can use the Ancillary loading capability ™ ' to load the new Secure image to the
intended location. Follow the steps below to perform an application upgrade. Refer to section 3.9 for
troubleshooting when using the Load Ancillary File function.
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1. Press to pause the program.

2. Load the new application images to the Secondary slot region using the Ancillary loading capability
from the top of the e? studio toolbar. Select Load as raw binary image and configure the Address to
0x38000.

& X
Load Ancillary File

Select an ancillary file for loading

File: | ${work5pace_loc:\app_ra6m3_secondary\Debug\lapp_raGmS_secondary.bin‘signed}I v || Workspa[e‘..l File System...

oad as raw binary image
Address: | ox3soo0 |

T

Figure 39. Load the Secondary Application Image for Overwrite Mode

3. Click Resume i . The overwrite occurs and the new image is executed. Now only the Blue LED should
be blinking.

4. Confirm the same configuration as shown in Figure 37, then click OK. The following output is printed and
only the blue LED blinks.

2@ Running the Secondary application with owerwrite update mode.
2@ The blue LED should be blinking.

@i
22> Running the Secondary application with owerwrite update mode.
a@: The blue LED should be blinkine,

Figure 40. Executing the Secondary Application Image for Overwrite Update Mode

3.8 Running the EK-RA6M3 Swap Test Update Mode Example with Test Mode

Follow the steps below to run the example projects for EK-RA6M3 using the MCUboot Swap Test Update
mode.

3.8.1 Import the Projects
Import the projects under Folder \raém3 swap test with bootloader to a Workspace.

The following example projects are included in this folder:

0x60000
Scratch Area (size=0x8000)
) \1= o 0x58000
5 Project Explorer = & ] Seconcary Secondary App
s app_rabm3_prima , Oro8000
I'?: pp_ _p r},r sg{ﬂaw Primary App
li= app_rabm3_secondary 0x18000
T i MCUboot
S5 ra_mcuboot_rabm3_swap_testmode: o o
K H X

Figure 41. Example Projects for RA6M3 Swap Test Update Mode

e Project ra mcuboot ra6m3 is the bootloader project.

e Project app raé6m3 primary is the initial Primary application project. This project blinks the three
LEDs on the EK-RABM3 kit.

e Project app ra6m3 secondary is the Secondary application project. This project blinks the blue LED
on the EK-RABMS3 Kkit.
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Follow section 3.2 to set up the Python signing environment if this is the first time you are signing the
application image.

3.8.2 Compile the Projects

The bootloader project needs to be compiled first. For each project, open the configuration.xml file,
click Generate Project Contents, and then click to build the project. Compile the projects in following the
order:

1. ra mcuboot raém3 swap testmode
2. app_ra6bm3 primary
3. app_ra6bm3 secondary

For the application projects, the post-build command will also sign the corresponding images. The signed
image is located under the \Debug folder and is named <project name>.bin.signed (for example,
/app_ra6tm3 primary/Debug/app raétm3 primary.bin.signed)

3.8.3 Debug the Applications and Boot the Primary Application
Right-click on project app_raém3_primary and select Debug As > Debug Configuration.

& o o v I N
BT < R | = Name: | app_rabm3_primary Debug_Flat

|t',r-ae filter text | [ Main | %% Debugger | B Startup| % Source| [] Common
[t | C/C++ Application Initialization Commands
| C/C++ Remote Application

[ ]Reset and Delay (seconds): 3

EASE Script
[ IHalt

't | GDB Hardware Debugging

't | GDB OpenOCD Debugging

'c | GDB Simulator Debugging (RH
0 Java Applet

[T Java Application

2 Launch Group Load image and symbols
i‘, Remote Java Application

R GDB Hard Deb ﬂename Load type Offset (hex)  On connect
v ;enesas ar_ ol eoud Program Binary [app_rabm3_primary.elf] Symbols only Yes :
¢ | app_rabm3_primary Debug_
TTSPp Tabm T secondary Debu ra_mcuboot_rabm3_swap_testmode.elf [C... Image and Symbols 0 Yes
B ra rr;cuboo; ra6ms3_swap.te app_rabm3_primary.bin.signed [CAMCUb... Raw Binary 18000 Yes

'] Renesas Simulator Debugging (

Figure 42. Debug Configuration RA6M3 Overwrite Update
Click Debug.

Click Resume twice " and boot the Primary image. All three LEDs should be blinking.

3.8.4 Open the J-Link RTT Viewer

Configure the RTT Viewer as shown in Figure 37. Observe the following output on the RTT Viewer. This
output shows the Primary application is being executed and all three LEDs are blinking.

82> | Running the Primary application with swap (test mode) update mode.

@8> | The Red, Blue and Green LEDs should be blinking.

Figure 43. Execution of Primary Application for Swap Test Mode
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3.8.5 Downloading and Running the Secondary Applications

During development, you can use the Ancillary loading capability ™ ' to load the new Secure image to the
intended location. Follow the steps below to perform an application upgrade. Refer to section 3.9 for
troubleshooting when using the Load Ancillary File function.

1. Press to pause the program.

2. Load the new application images to the Secondary slot region using the Ancillary loading capability "
from the top of the e? studio toolbar in a similar way as Figure 39. Select Load as raw binary image and
configure the Address to 0x38000.

3. Click Resume = . A swap occurs and the new image is executed. Now only the blue LED should be
blinking.

4. Confirm the same configuration as shown in Figure 37, then click OK. The following output is printed and
only the blue LED should blink.

@0> Running the Secondary application with swap (test mode) update mode.

@8> The blue LED should be blinking.

Figure 44. Executing the Secondary Application Image for Swap Test Update Mode

5. Pause and reset the application from the debugger.

3.9 Troubleshooting
When running the example projects, you may experience USB Debug connection or the RTT Viewer

connection issue when using the “Load Ancillary File” button " to download the Secondary image. To
recover from these failures:

e |f the USB Debug connection disconnects, the recommendation is to try out another available USB port
on the development PC for the USB Debug connection. If failure persists, contact Renesas support.

e Ifthe RTT Viewer disconnects, the recommendation is to power cycle the board and restart the debug
session.

4. Creating the Bootloader

This section provides a walk-through of the bootloader creation of the example projects as well as how to link
the standalone application with the bootloader. For most of the steps, the considerations and configurations
in creating bootloader with the different upgrade mode are common. Whenever there is a difference in the
implementation of the different update mode, the difference will be addressed.

The walk-through of the bootloader creation in this section targets the bootloader used in section 3.3 for the
TrustZone® enabled system. Wherever there is a need to address the Non-TrustZone enabled
implementation, it will be addressed.

4.1 Creating a Bootloader Project for RA Family

The screen captures used in these sections are based on the RA6M4 based bootloader projects used in
section 3.3, 3.4, and 3.5. Follow this section to establish the bootloader projects used in section 3.3, which
uses Overwrite Only as the application update mode. Updates needed for the bootloader projects used in the
section 3.4 and 3.5 are addressed.

The creation of the RA6M3 based bootloaders used in section 3.7 and 3.8 are very similar. Wherever there is
a difference in the operation, it will be addressed inline.
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4.1.1 Start Bootloader Project Creation with e? studio
Follow the steps below to create the initial bootloader project based on EK-RA6M4:

1. From the e? studio Workspace, navigate to the File > New > Renesas C/C++ Project > Renesas RA
and then select Renesas RA C/C++ Project and press Next.
Provide the project name ra mcuboot rae6m4 and click Next. The exact name needs to be provided to
follow the default instructions in this section. If a different name is provided, all instructions related with
the name of the bootloader project need to be updated accordingly.
In the next screen, select FSP version 5.5.0 and the EK-RA6M4 board. Use the default Debugger
setting J-Link Arm and click Next.
Note that if the creation process is using other newer FSP versions, some details on the error messages
shown when the MCUboot module is initially added may be different. Adapt the actions accordingly to
satisfy the dependencies.

2. When the following screen appears, select Flat (Non-TrustZone) Project.

Q Renesas RA C/C++ Project O x

Renesas RA C/C++ Project %

Project Type Selection

Project Type Selection

@ Flat (Non-TrustZone) Project
» Renesas RA device project without TrustZone separation
» All code, data and peripheral settings will be configured in
this project
» Renesas RA device will remain in secure mode
s EDMAC RAM buffers will automatically be placed in non-
secure RAM

() TrustZone Secure Project

s Renesas RA device project for TrustZone secure execution

s All code, data and peripherals placed in this project will be
initialized as secure

» Secure project settings such as TrustZone partitions, linker
maps and a list of secure peripherals will be passed to a
selected non-secure project

s After initialization, a call to the non-secure startup handler
will be made

() TrustZone Non-secure Project
» Renesas RA device project for TrustZone non-secure execution
» All code, data and peripherals placed in this project will be
initialized as non-secure
» Must be associated with a secure project or smart bundle
s Non-secure startup handler will be called after secure code
initialization

@ < Back Finish Cancel

Figure 45. Choose Flat Project as Project Type
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3. Choose Executable as the Build Artifact Selection and No RTOS. Click Next.

Q Renesas RA C/C++ Project O X

Renesas RA C/C++ Project
Build Artifact and RTOS Selection

RTOS Selection
| No RToS |

Build Artifact Selection

© Executable
® Project builds to an executable file

O static Library
® Project builds to a static library file

() Executable Using an RA Static Library
® Project builds to an executable file
& Project uses an existing RA static library project

Cancel

4.

Figure 46. Choose Executable and No RTOS

In the next screen, select the project template.

Choose Bare-Metal — Minimal as the Project Template Selection and click Finish.

Update the Pin configuration file.

The project will now be created, and the bootloader project configuration will be displayed. Select the
Pins tab and deselect the Generate data check box. Use the pull-down menu to switch from RA6M4 EK
to R7TFA6MA4AF3CFB.pincfg for the Select Pin Configuration option, select the Generate data check
box and enter g_bsp_pin_cfg.

Select Pin Configuration

| reemaex |

V‘ Manage

_|_-1| Export to CSV file j Configure Pin Driver Warnings

Figure 47. Uncheck Generate Data for RA6M4 EK Pin Configuration

Select Pin Configuration

I‘ R7FA6MAAF3CFB.pincfg

VI Manage

_5,.1] Export to CSV file E‘Conﬁgure Pin Driver Warnings

Generate data: | gfbspfp\'nfcfg‘

Figure 48. Select R7TFA6M4AF3CFB.pinCfg and Generate data g_bsp_pin_cfg

Note that when we select the Flat Project model, the I/Os are configured as Secure by default. Updating
the pin configuration as shown above selects the pin configuration with the minimal number of pins
defined because any I/O that is defined in the Flat project will not be available for use in the Non-Secure
application and can only be accessed by the Secure application.

6. Add the MCUboot module.

Change to the Stacks tab and select New Stack > Bootloader > MCUboot.

HAL/Common Stacks % | New S~

Al >

. b

42 g_ioport 1/O Port A”al_og il ii

(r_ioport) Gudic ? ===

Bootloader >| 4+ MCUboot ]

@ CapTouch > 4 MCUboot Image Utilities
Connectivity > [ —

Figure 49. Add the MCUboot Module
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4.1.2 Resolve the Configurator Dependencies

After the MCUboot module is brought into the configurator, follow the steps in this section to resolve the
dependencies:

1. Resolve the following dependency of the MCUboot by adding the MbedTLS (Crypto Only) stack.

HAL/Common Stacks % | New Stack > =% Extend Stack > %] Remove

rf> MCUboot

A stack element with a bar of this color indicates MCUboot' is a Module instance
This instance may be referenced by one other module instance only.

(i)

Error: ASN.1 parser is required for ECDSA if TinyCrypt or Custom Crypto (Protected Mode) is used as crypto stack.

@ MCUboot Port for RA (rm_ Error-related property:

MCUboot > Signing and Encryption Options > Signature Type

Error: ASN.1 parser must not be added if MbedTLS is used as crypto stack

= - E

% Add Requires a crypto %7 Add Requires Flash %7 Add External Memory
stack Implementation
(Optional)

Figure 50. MCUboot Module Dependency
Left click on Add Requires a crypto stack, choose New and add the MbedTLS (Crypto Only) stack.

Stacks Conflguratlon Generate Project Content

Threads - HAL/Common Stacks % | New Stack >
v & HAL/Common -
-.'bu' g_ioport I/O Port (r_ioport) g% MCUboot
@ MCUboot
@
-
T
nt‘? MCUboeot Port for RA (rm_mcuboot_port)
@
Y
\ | I
" Add Requires a crypto %7 Add Requires Flash %7 Add External Memory
stack Implementation
(Optional)
New > ‘9 MCUboot Custom Crypto (Protected Mode) —
4 MCUboot TinyCrypt (S/W Only) |
F’ MbedTLS (Crypto Only)
Figure 51. Add MbedTLS (Crypto Only) Module
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2. Configure the Mbed Crypto dependencies.

Follow the prompt in Figure 52 to update the corresponding properties for the MCUboot Port for RA
Module.

HAL/Common Stacks % | New Stack > = Ex X ®_ Remove
& MCUboot
-
T
@ MCUboot Port for RA (rm_mcuboot_port) | | 4 MCUboot logging % Add [Opti
A stack element with a bar of this color indicates ‘MCUboot Port for RA (rm_mcuboot_port)’ is a Module instance.
G_) This instance may be referenced by one other module instance only.

Error: Requires Flash Driver
[Error: MBEDTLS_THREADING_C in MbedTLS (Crypto Only) must not be defined under MbedTLS (Crypto Only)|Common|General[MBEDTLS_THREADING_C.
Error-related property:
MbedTLS (Crypto Only) > General > MBEDTLS THREADING C
Error: MBEDTLS_THREADING_ALT in MbedTLS (Crypto Only) must not be defined under MbedTLS (Crypto Only)[Common|General| MBEDTLS_THREADING_ALT

@ Error-related property:
Mbed Crypto H,
poi M MbedTLS (Crypto Only) > General > MBEDTLS THREADING ALT
(rm_psa_crypto) Error: MBEDTLS_MEMORY_BUFFER_ALLOC_C in MbedTLS (Crypto Only) must be defined under MbedTLS (Crypto Only)|Common|General|[MBEDTLS_MEMORY_BUFFER_ALLOC_C.
)] Error-related property:
Iy MbedTLS (Crypto Only) > General > MBEDTLS MEMORY BUFFER ALLOC C
—_—
&8 SCE Compatibility Error: Code Flash Programming must be Enabled under FlashCommon|Code Flash Programming Enable
Mode Error: Data flash bgo must be disabled under Flash|Module|Data Flash Background Operation
-
—
% Add Key Injection for
PSA Crypto (Optional)

Figure 52. Dependencies of MCUboot Module for RA Stack
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Configure the following properties:
HAL/Common Stacks
1 i
& Add Requires Flash % Add External Memaory
Implementation
{Optional)
<
iP-Clocb.PiM.lmenupts:Ewnt Links @ Stacks Cornponents-
wser | ] Properties X
[Crypto Only)
Property Value
> Hardware Acceleration
> Platform
~ General
MBEDTLS_PSA_CRYPTO_DRIVERS Undefine
MBEDTLS_DEPRECATED_WARNING Undefine
MBEDTLS_DEPRECATED_REMOVED Define
MBEDTLS_CHECK_RETURN_WARNING Undefine
MBEDTLS_ERROR_STRERROR_DUMMY Define
MBEDTLS_MEMORY_DEBUG Undefine
MBEDTLS_MEMORY_BACKTRACE Undefine
MBEDTLS_PSA_CRYPTO_CLIENT Undefine
MBEDTLS_PSA_CRYPTO_SPM Undefine
MBEDTLS_PSA_ASSUME_EXCLUSIVE_BUFFERS Undefine
MBEDTLS_SELF_TEST Undefine
MBEDTLS_THREADING_ALT Undefine |
MBEDTLS_THREADING_PFTHREAD Undefine
MBEDTLS_USE_PSA_CRYPTO Undefine
MBEDTLS_VERSION_FEATURES Define
MBEDTLS ERROR C Defi
MBEDTLS_MEMORY_BUFFER_ALLOC_C Define
MBEDTLS_PSA_CRYPTO_C Define
MBEDTLS PSA CRYPTO SE C Undefine
MBEDTLS_THREADING_C Undefine
- G L undeli
MBEDTLS_VERSION_C Define
MBEDTLS_MEMORY _ALIGN_MULTIPLE Undefine
MBEDTLS_MEMORY_ALIGN_MULTIPLE value 4
MBEDTLS_CHECK_RETURN Define
MBEDTLS_IGNORE_RETURN Undefine
MBEDTLS_PSA_CRYPTO_CONFIG Undefine
» Cipher
> Public Key Cryptography (PKC)
Figure 53. Configure Highlighted Properties for the MbedTLS (Crypto Only) Stack
Add the r_flash_hp module:
| =
A I | L
%" Add External Memory
> |4 Flash (r_flash_hp)
Figure 54. Add the r_flash_hp Stack
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Configure the r_flash_hp stack:

HAL/Common Stacks

|©
|

¢ MbedTLS (Crypto Only)

@©

@ g_flash0 Flash
(r_flash_hp)

@

®

Add External Memory
Implementation
(Optional)

<

BSP |Clacks | Pins | Interrupts | Event Links | € Stacks| Components

Browser [ Properties X
) Flash (r_flash_hp)

Property
~ Common
g

Value

ode Flash Programming Enable
Data Flash Programming Enable

D, SP)
Enabled
Disabled|

~ Module g_flash0 Flash (r_flash_hp)

l Data Flash Batl:ﬁmund Oeeratlun

Dlsabledl

Callback
Flash Ready Interrupt Priori
Flash Error Interrupt Priority

NULL
Disabled
Disabled

Figure 55. Configure the r_flash_hp Stack

w

Hover the cursor over MbedTLS (Crypto Only) stack. You will see warnings as shown in Figure 56.
4. Under the BSP tab, set up the stack and heap size to support ECC:
e RA Common > (set Main stack size to 0x1000 and Heap size to 0x400)

#_ Remove

HAL/Common Stacks 4| New Stack >

T T T a
@ g_flashO Flash % Add External Memory

(r_flash_hp) Implementation

&% MbedTLS (Crypto Only)

C A stack element with a bar of this color indicates ‘"MbedTLS (Crypto Only)' is a common module instance.
I— This instance may be referenced by multiple other module instances across multiple stacks.

4 Error: A minimum heap of 0x400 is required to use ECC. To disable ECC, under Common|PKC|ECC, undefine MBEDTLS_ECP_C and anything else that uses ECC (MBEDTLS_ECDSA_C).
< Error-related property:
MbedTLS (Crypto Only) > Public Key Cryptography (PKC) > ECC > MBEDTLS ECP C
=8 Error: A minimum heap of 0x1500 is required to use RSA. To disable RSA, under Common|PKC|RSA undefine MBEDTLS_RSA_C, and under Common|PKC, undefine MBEDTLS_PK_C, MBEDTLS_PK_PARSE_C, MBEDTLS_PK_WRITE_C
row: Error-related property:
MbedTLS (Crypto Only) > Public Key Cryptography (PKC) > RSA = MBEDTLS RSA C
Error: A minimum heap of 0x200 is required to use AES. AES cannot be disabled

Flas|

Pre Error-related property:

h MbedTLS (Crypto Only) > Cipher > MBEDTLS AES C
Error: A minimum stack of 4K (0x1000) is required. If used in an RTOS thread, the thread stack should instead be at least 0x1000.

Figure 56. Dependencies of Mbed TLS (Crypto Only) Stack

5. Disable RSA following the prompt in Figure 57. This bootloader design uses ECC for signature
generation. Disable the RSA algorithm to save the BSP Heap size.

HAL/Common Stacks %] New Stack > #_| Remove

I I I =
d5 MbedTLS (Crypto Only) @ g flashO Flash %9 Add External Memory
(r_flash_hp) Implementation

A stack element with a bar of this color indicates '"MbedTLS (Crypto Only)' is a common module instance.
This instance may be referenced by multiple other module instances across multiple stacks.

Error: A minimum heap of 0x1500 is required to use RSA. To disable RSA, under Common|PKC|RSA undefine MBEDTLS_RSA_C, and under Common|PKC, undefine MBEDTLS_PK_C, MBEDTLS_PK_PARSE_C, MBEDTLS_PK_WRITE_C.

i MbedTLS (Crypto Only) = Public Key Cryptography (PKC) > RSA > MBEDTLS RSA C I

Figure 57. Dependencies of RSA
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HAL/Common Stacks % | Ne
| |
| A ]
T T T
% MbedTLS (Crypto Only) @ g flash0 Flash & Add External Memory
(r_flash_hp) Implementation
{Optional)
(i) ®
-

<
BSP | Clocks Pins | Interrupts | Event Links | Stacks | Components

irowser ijroperties X

5 (Crypto Only)

Property Value
~ Public Key Cryptography (PKC)
DHM
ECC
v RSA

MBEDTLS_PK_RSA_ALT_SUPPORT Undefine
MBEDILS RSA NO CRT Define

L vBEDTLS RSA C Undefine|
MBEDTLS_RSA_GEN_KEY_MIN_BITS Undefine
MBEDTLS_RSA_GEN_KEY_MIN_BITS value 1024

Figure 58. Disable RSA

At this point the error message in the stack window should have been resolved.
6. Decide the number of application images.

For MCUs with TrustZone support:

e |If the application uses TrustZone, there will be two application images in each slot: secure and non-
secure application. In this case, set the Number of images per Application to 2.

e If the application does not use TrustZone, there will be one application image in each slot. In this
case, set the Number of images per Application to 1.

e The bootloader used in section 3.3 uses TrustZone, so for this example bootloader, set the Number
of images per Application to 2. MCUboot > Common > General > Number of images per
Application (change from 1 to 2).

For MCUs without TrustZone support, set this property to 1.

7. Configure the Flash Layout for RA6M4 Overwrite Update as shown below based on the standalone
application projects described in section 5. For your application projects, you can follow the guidelines in
section 2.3 to design the bootloader memory allocation. This configuration matches the bootloader used

in section 3.3.
—— 0x70000
v Flash Layout Secondary
v TrustZ slot Secondary Non-Secure App
rustZone
Non-Secure Callable Region Size (Bytes) 0x400 ———  0x50000
Non-Secure Flash Area Size (Bytes) (TrustZone Non-Secure) 0x20000 Primary Primary Non-Secure App
Non-Secure Callable RAM Region Size (Bytes) 0x0 - 0X30000
E— X
Non-Secure RAM Regicn Size (Bytes) (TrustZone Non-Secure) 0x2000 Primary Primary Secure App
Image 2 Header Size (Bytes) 0x200 = 0x20000
Bootloader Flash Area Size (Bytes) 0x10000 Secondary Secondary Secure App
lot
Image 1 Header Size (Bytes) 0x200 = A o ——— 0x10000
Image 1 Flash Area Size (Bytes) 0x10000 R ———  0x10000
Scratch Flash Area Size (Bytes) 0x0 et 0x0

Figure 59. Memory Configuration of Overwrite Update Mode RA6M4
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Configure the MCUboot module and application memory allocation based on RA6M4 Swap Update
mode as shown below based on the standalone application projects described in section 5. This
configuration matches the bootloader used in section 3.4.

0x80000
zi‘fo"“aw Secondary Non-Secure App
0x60000
~ Flash Layout
v TrustZone Primary Primary Non-Secure App
Non-Secure Callable Region Size (Bytes) 0xC00
Non-Secure Flash Area Size (Bytes) (TrustZone Non-Secure)  0x20000 Primary 0x40000
Non-Secure Callable RAM Region Size (Bytes) 0x0 slot Primary Secure App
Non-Secure RAM Region Size (Bytes) (TrustZone Non-Secure) 0x2000 0x30000
Image 2 Header Size (Bytes) 0x200 3?;?“““” Secondary Secure App
Bootloader Flash Area Size (Bytes) 0x18000 0x20000
Image 1 Header Size (Bytes) 0x200 Scratch Area (size=0x8000)
Image 1 Flash Area Size (Bytes) 0x10000 MCUboot 0x18000
Scratch Flash Area Size (Bytes) 0x8000 0x0

Figure 60. Memory Configuration of Swap Update Mode RA6M4

Configure the MCUboot module and application memory allocation based on RA6M4 Direct XIP mode
based on the example projects presented in section 3.5. This configuration matches the bootloader used
in section 3.5.

~ Flash Layout

v TrustZone 0x30000

Mon-Secure Callable Region Size (Bytes) ] Scratch Area (size=0x0)
MNon-Secure Flash Area Size (Bytes) (TrustZone Non-Secure) 0 Secondary 0x30000
Non-Secure Callable RAM Region Size (Bytes) 0x0 slot Secondary App
Mon-5Secure RAM Region Size (Bytes) (TrustZone Mon-5Secure) 0 0x20000
Image 2 Header Size (Bytes) 0x200 Primary Primary App

Bootloader Flash Area Size (Bytes) 0x10000 slot

Image 1 Header Size (Bytes) 0x200 0x10000

Image 1 Flash Area Size (Bytes) 0x10000 MCUboot

Scratch Flash Area Size (Bytes) 0x0 0x0

Figure 61. Memory Configuration of Direct XIP Update Mode RA6M4

Configure the MCUboot module and application memory allocation based on the RA6M3 Overwrite
Update mode based on the example projects presented in section 3.7. This configuration matches the
bootloader used in section 3.7.

¥ Flash Layout

0x58000
v TrustZone .
. . Scratch Area (size=0x0)
Non-Secure Callable Region Size (Bytes) 0x0 0x58000
Non-Secure Flash Area Size (Bytes) (TrustZone Non-Secure) 0x0 Secondary
Non-Secure Callable RAM Region Size (Bytes) 0x0 slot Secondary App
Non-Secure RAM Region Size (Bytes) (TrustZone Non-Secure) 0x0 0x38000
Image 2 Header Size (Bytes) 0x200 ;!Taw Primary App
Bootloader Flash Area Size (Bytes) 0x18000 0x18000
Image 1 Header Size (Bytes) 0x200
. MCUboot
Image 1 Flash Area Size (Bytes) 0x20000
Scratch Flash Area Size (Bytes) 0x0 0x0
Figure 62. Memory Configuration of Overwrite Update Mode RA6M3
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Configure the MCUboot module and application memory allocation based on RA6M3 Swap Test Update
mode based on the example projects presented in section 3.8. This configuration matches the
bootloader used in section 3.8.

0xB0000

~ Flash Layout
w TrustZone Scratch Area (size=0x8000)

MNon-Secure Callable Region Size (Bytes) 0x0 0x58000
MNon-Secure Flash Area Size (Bytes) (TrustZone Non-Secure) 0x0 Secondary
MNon-Secure Callable RAM Region Size (Bytes) 0x0 slot SEELTEPAED
Non-Secure RAM Region Size (Bytes) (TrustZone Non-Secure) 0x0 . 0x38000
Image 2 Header Size (Bytes) 0x200 ey Primary App

Bootloader Flash Area Size (Bytes) 0x18000 0x18000

Image 1 Header Size (Bytes) 0x200 MCUboot

Image 1 Flash Area Size (Bytes) 0x20000 00

Scratch Flash Area Size (Bytes) 0x8000

Figure 63. Memory Configuration of Swap Test Update Mode RA6M3

For the configuration of the swap test mode run time support, refer to application note R11AN0516 to
understand the operation.

4.1.3 Setting up the Booting Authentication Support
You can choose to use the default pair of public/private keys included in MCUboot for testing purposes:

e The default public keys are defined in /ra_mcuboot raémé/ra/mcu-
tools/MCUboot/sim/mcuboot-sys/csupport/keys.c.
e The default private keys are included in folder /ra mcuboot raém4/ra/mcu-tools/MCUboot/sim.

v E-jc ra_mcuboot_rabm4 [Debug]
_;‘;;.} Binaries
[} Includes
v |'|J_:!- ra
{_—JA' arm
(= board
= fsp
v ,,_—f mcu-tools
v = MCUboot
(= boot
= scripts
v (2= sim
v (= mcuboot-sys

[21 enc-ec256-priv.pem

[51 enc-ec256-pub.pem Used for image encryption, not used
[E] enc-rsa2048-priv.pem in this application project

”] root-ec-p256.pem
21 root-rsa-2048.pem Used for image signing
2] root-rsa-3072.pem

Figure 64. Example Public Keys and Private Keys Included in MCUboot Port Stack

To use the example keys, select Add Example Keys > New > MCUboot Example Keys (NOT FOR
PRODUCTION).
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ry
1 I T
4 MCUboot logging . Add [Optional] Add %' Add ASN.1 parser if
Example Keys using TinyCrypt or -~
® MNew > 'i? MCUboot Example Keys (NOT FOR PRODUCTION)
o ] =
[ [
[ —
% Add External Memory Bl
Implementation
(Optional) w

Figure 65. Add the MCUboot Example Key

Note: The example public key and private key used in the MCUboot is for testing purposes only. Refer to

section 2.6 for guidelines on selecting the public key and private key for production support.
Application Project R11AN0567 includes procedures to create customized key pair preparation. Refer
to R11ANO0567 to create customized key pairs.

4.1.4 Setting up the Application Authentication Signature Type

There are three signature types supported in FSP as shown below. Open the Property page of stack
MCUboot > Common > Signing and Encryption Options to look at the signing options. In this example
implementation, ECDSA P-256 is used for all the example bootloaders demonstrated in section 3.

4.1.5 Add MCUDboot Initialization Code

Follow the steps below to add the MCUboot activation code and compile the bootloader:

1.

Add the source code and compile the bootloader.

Follow the steps below to add the source code to the bootloader project and compile the project.

e Openhal entry.c.

e Open Developer Assistance.

¢ Go to HAL/Common > MCUboot > Quick Setup. Drag Call Quick Setup to the top of the
hal entry.c file before the hal entry () function call.

e Call this function at the top of the hal entry () function
e mcuboot quick setup();

Notes on the mcuboot_quick_setup function

e The main functionality established in the bootloader project is established by function

mcuboot quick setup, which performs the following functions:

e The boot go function does most of the functions of a bootloader except the final step of
jumping to the main image. This function returns a structure pointer (rsp for return structure
pointer) for the image to boot from.

e The RM MCUBOOT PORT BootApp function cleans up resources used by the bootloader and
jumps to the application image.

2. Compile the bootloader project.
e Save the project (save the source code and the configuration.xml file) and click Generate
Project Content and then compile the project.
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5. Using the Bootloader with Applications

A set of existing non-bootloader-based projects are used to demonstrate how to configure existing
application projects to use the bootloader. General guidelines are also provided for adapting to other existing
applications. Unzip example projects no bootloader.zip.

These projects have the same functionality as the projects demonstrated in section 3.3 except these projects
are not configured to use the bootloader. Follow the steps below to configure the standalone application
projects to use the bootloader and sign the application.

5.1.1 Import the Standalone Application Projects

Import the RA6M4 standalone example project to the same workspace as the bootloader project you created
in the previous section. In this section, we will update these existing projects to use the bootloader created in
the previous section.

=% app_rabmé4_ns_primary
I app_rabm4_ns_secondary
e app_rabm4_s_primary

=2 app_rabmd4_s_secondary

Figure 66. Standalone Example Projects for RA6M4 with No Bootloader support
5.1.2 Configure the Application Projects to Use the Bootloader

We will now alter the project Properties configuration to have it use the bootloader. Right-click on the

app ra6m4 s primary folderin the Project Explorer and select Properties. Select C/C++ Build>Build
Variables, click Add and set the Variable name to BootloaderDataFile and check the Apply to all
configurations box. Change the Type to File and enter
${workspace_loc:ra_mcuboot_raém4}/Debug/ra_mcuboot_raém4.bld for the value. Click OK to save the
changes.

. t o
[type fiter text {8 Define a New Build Variable ps P ¢
Resource |
Builders Variable name: | BootloaderDataFile v
~v C/C++ Build Apply to all configurations Manage Configurations..
Build Variables Type: File o
Environment
Logging Value: Ia_loc:ra_mcuboot_ra6m4};‘Debugfra_mcuboot_ra6m4.bld ] Browse
L Add..
Settings
Tool Chain Editor Edit...
C/C++ General
MCU Delete
Project Natures
Project References
Renesas QE
Run/Debug Settings
| 5 vorda Cance
{ Validation ance
T
Build Variables are IDE only variables, which can be used for string substitution when defining external builder
configuration, such as environment variable value or command line parameter in form of ${VAR}, internal builder
may use them directly.
Restare Defaults Apply
@ Apply and Close Cancel
Figure 67. Configure the Build Variable to Use the Bootloader
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Follow the same procedure and settings as shown in Figure 67 to configure the other three projects:

e app ra6tm4 ns primary
e app ratmé4 s secondary

e app ratm4 ns secondary

5.2 Signing the Existing Application Projects to Use the Bootloader

The signing command for the application image will be automatically generated when the bootloader is
compiled. In the Project Explorer, navigate to the <boot project> <debug> <boot project>.bld
file. The signing command is under the section <image>.

Note: If you rebuild the bootloader project after changing any of the signing and signature Properties of the
MCUboot module, you will need to select Generate Project Content again to bring in the
updated .bld file.

Each application can have a defined version number. This version number can be used in the Overwrite
Upgrade mode when Downgrade Prevention is Enabled. This is achieved by defining an Environment
Variable: MCUBOOT_IMAGE_VERSION. If there is signature verification, then it is necessary to set the
Environment Variable: MCUBOOT_IMAGE_SIGNING_KEY with value in this case is

${workspace_loc:ra_mcuboot_raém4}/ra/mcu-tools/MCUboot/root-ec-p256.pem.

& Properties for app_rabmd_s_primary

| type filter text Environment

Resource
Builders
~ C/C++ Build Configuration: Debug [ Active ]

Build Variables

Environment

~ | | Manage Configurations...

SZ?tlgnI;E: Environment variables to set Add...
Tool Chain Editor Variable Value Origin Select..
C/C++ General CWD CAMCUboot\r11an0497\.. BUILD SYSTEM
MCU GCC_VERSION 13.2.1 BUILD SYSTEM Edit...
Project Natures PATH C\Users\a5145401\App...  BUILD SYSTEM Delete
Project References PWD CA\MCUboot\r11an0497\.. BUILD SYSTEM
Renesas QE TCINSTALL C\Users\a5145401\App...  BUILD SYSTEM Undefine
Run/Debug Settings TC_VERSION 13.2.1.arm-13-7 BUILD SYSTEM
Task Tags
Validation
(® Append variables to native environment
(0 Replace native environment with specified one
Restore Defaults Apply

Figure 68. Add New Environment Variable

Add Environment variable for the application image version.

& New variable

Name:l MCUBOOT_IMAGE_VERSION I

Value: I 1.0.0 i Variables

Add to all configurations

[ ] o

Figure 69. Add MCUBOOT_IMAGE_VERSION Variable

Add an Environment variable to configure the application image signing key.
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Q New variable

Name: lMCUBOOT_IMAGE_SIGNING_KEY '
Value: Ia6m4}/ra/mcu-tools/MCUbooUroot-ec-p256.pemI

Add to all configurations

Variables

o |

Cancel

Figure 70. Add MCUBOOT_IMAGE_SIGNING_KEY Variable

S Properties for app_rabm4_s_primary m] X

‘ type filter text

Resource
Builders
~ C/C++ Build

Environment

Configuration: Debug [ Active ]

Environment variables to set

~ | | Manage Configurations...

Settings Add.
Tool Chain Editor Variable Value Origin e
C/C++ General CWD C\MCUbaot\r11an0497\example_projects_no_bootloader\app_raém4_s_primary\De.. BUILD SYSTEM
MCU GCC_VERSION 13.2.1 BUILD SYSTEM Edit...
Project Natures MCUBOOT_IMAGE _SIG... ${workspace_locra_mcuboat_reabmd4}/ra/mcu-tools/MCUboot/root-ec-p256.pem USER: CONFIG bakn
Project References MCUBOOT_IMAGE_VER... 100 USER: CONFIG
Renesas QE PATH C\Users\a514540T\AppData'Local\Programs\Renesas\RA\e2studio_v2024-07_fsp_v.. BUILD SYSTEM Undefine
Run/Debug Settings PWD C\MCUbaot\r11an0497\example_projects_no_bootloader\app_raém4_s_primary\De.. BUILD SYSTEM
Task Tags TCINSTALL C\Users\a5145401\AppData\Local\Programs\Renesas\RA\e2studio_v2024-07_fsp_v.. BUILD SYSTEM
Validation TC_VERSION 13.2.1.arm-13-7 BUILD SYSTEM
@ Append variables to native environment
() Replace native environment with specified one
Restore Defaults Apply
©

Figure 71. Configure the Signing Key and Application Version
Note: The private key used for signing the application image is indicated in the signing command.

/ra/mcu-tools/MCUboot/root-ec-p256.pem is used for the example bootloader. This key is
used for testing purposes only. For real world use case and production support, you MUST change
this to the private key of their choice.

To be able to always recompile the project when the environment variables or the linker script are updated,
we recommend adding a Pre-build step to always delete the .e1f file as shown in Figure 72.

| type filter text ‘ Settings
Resource
Builders i . Ty Acti
v C/Ca+ Build Configuration: |Debug [ Active ]

Build Variables
Environment

® Tool Settings ® Toolchain| # Build Steps | B

Pre-build steps

Command(s):
| rm -f §${ProjName}.elf I

Tool Chain Editor
C/C++ General

Figure 72. Configure the Pre-build Command
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Follow the same procedure to configure the other three projects:

e app raétm4 ns primary
e app ratm4 s secondary
e app ratm4 ns secondary

5.2.1 Click Generate Project Content and Compile All Four Application Projects
For both Primary and Secondary applications, compile the Secure application first and then the Non-Secure
application.

5.2.2 Configure the Debug Configuration
1. Open the Debug Configurations: app_raém4_s_primary > Debug As > Debug Configurations
Make sure that app_rabm4_s_primary Debug is selected and select the Startup tab.

Q Debug Configurations O X

Create, manage, and run configurations z@'\
& = -
BT < = ¥ ‘ - Name: | app_rabm4_s_primary Debug |
| type filter text | [ Main | %5 Debugger, % Source| [£] Common

[e] ¢/C++ Application Initialization Commands
[£] ¢/C++ Remote Application [JReset and Delay (seconds): 3
EASE Script

[ ] GDB Hardware Debugging [

[T] GDB OpenOCD Debugging

[c*] GDB Simulator Debugging (RH85(
] Java Applet

[ Java Application

2 Launch Group Load image and symbols

- i
&= Remote Java Application . Filename Load type Offset (hex)  On connect
v [£] Renesas GDB Hardware Debuggin - - Add..
) Program Binary [app_rabm4_s_primary.elf] Symboaols only Yes H
[c¥ app_raém4_ns_primary Debug_ Edit
[£7] app_rabmé ns_secondary Debu o
¢ *| app_rabm4_s_primary Debug Remove
€| app_rabmé_s_secondary Debug :
[£7] ra_mcuboot_rasmé4 Debug_Flat LEE Y
[£*] Renesas Simulator Debugging (RX Move down
Runtime Options
[[]Set program counter at (hex):
Set breakpoint at:
[“1Resume h
< >
Revert Apply

Filter matched 17 of 19 items

Figure 73. Configure the Primary Secure Project Debug Startup
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2. Set up the Debug Configurations.
Click Add... and then Workspace. Navigate to the ra_mcuboot_raém4 project and select the
ra_mcuboot_raébm4.elf file from the debug folder. Click OK.
Create, manage, and run configurations ﬁ\(
7 = >
1Py < = X ‘ El M Name: | app_rabmd4_s_primary Debug |
|tyoef ter text | [ Main | %% Debugger | B Startup| %~ Source| (-] Common
[£] ¢/C++ Application Initialization Commands =
(€] ¢/C++ Remote Application [ Reset and Delay (seconds): 2
EASE Script
[£] GDB Hardware Debugging L Hait
[£] GDB OpenOCD Debugging
[c*] GDB Simulator Debugging (RH85(
¥ Java Applet
[77 Java Application
& Launch Group Load image and Q Add download module b’
L?, Remote Java Application Fil o
[£7] Renesas GDB Hardware Debuggin fename Specify download module name: ! n connect Add...
v - i 99 Program Bir| p : Yes
= app_raém4_ns_primary Debug_ | $iworkspace_loc\ra_mcuboot_rabm#\Debug\ra_mcuboot_rabmé4.elf} Edit...
] app_raébm4_ns_secondary Debu
7] app_ra6m4_s_primary Debug Variables... Search Project... File System... Remove
[c7] app_rabm4_s_secondary Debug
Mowvi r
[£7] ra_mcuboot_rabm4 Debug_Flat [— UEIE T
[£7] Renesas Simulator Debugging (RX Cancel Move down
Runtime Options
[ set program counter at (hex):
Set breakpoint at:
["1Resume e
< >
Revert Apply

Filter matched 17 of 19 items

®

Figure 74. Add the Bootloader Project

Click Add again and add the app_raém4_ns_primary project binary app_raém4_ns_primary.elf as in
the prior step. Click OK.

QAdd download module X

Specify download module name:

| .pace_Ioc:\app_ra6m4_ns_primary\Debul\app_ra6m4_ns_primary.elf} I

Variables... Search Project... Workspace... File System...

Figure 75. Add the Non-Secure Project
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Change the load type of the Program Binaries for the app_raém4_ns_primary and
app_rabmd4_s_primary to Symbols only by clicking on the cell for load type and selecting Symbols
only from the drop-down menu.

Load image and symbols

Filename Load type Offset (hex)  On¢ Add
Program Binary [app_raém4_s_primary.elf] Symbols only I Yes
ra_mcuboot_raém4.elf [C:\Users\trung.tr... Image and Symbols 0 Yes Edit...
app_rabmd _ns_primary.elf [C:\Users\trun... Symbols only | 0 Yes Remove
Move up
Move down
< >

Runtime Options

[Jset program counter at (hex):

Set breakpoint at: ~

< >

Revert Apply

Figure 76. Select to load Symbols only for the Secure and Non-Secure Project

3. Add the signed binary image to the download options using Raw Binary Load type.

Load image and symbols

Filename Load type Offset (hex)  On connect
Program Binary [app_rabm4_s_primary.elf] Symbols only Yes
ra_mcuboot_rabm4.elf [C\MCUboot\example pr.. Image and Symbols 0 Yes
app_rabm4_ns_primary.elf [C\MCUboot\exampl.. Symbols only 0 Yes
app_rabm4 s primary.binsigned [C\MCUboot\e.. Raw Binary 20000 Yes
app_rabm4_ns_primary.binsigned [C\MCUboot\.. Raw Binary 30000 Yes

Figure 77. Load the Signed Images

Note that for different update modes and different application images, the load address needs to be
update. For the example projects included in this application project, you can reference the memory
configuration images include in Figure 59 to Figure 63 to set up the load address.

4. After the above is set up, follow section 3.3 to run the projects if Overwrite Update mode is used or follow
section 3.4 to run the projects if Swap Update mode is used.
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5.3 Mastering and Delivering a New Application

Mastering and delivering a new application involves similar steps described above in section 4.2 and section
5.2. Typically, the following aspects must be considered in the designing of delivering new applications:

1. Create the new application and sign the new application by following the steps below:
A. Refer to the Renesas RA Family Security Design with Arm® TrustZone®- IP Protection for new
project creation with TrustZone support.
B. Refer to section 4 to configure the new application to use the bootloader and sign the new
application.
2. Download the new application to the Secondary slots.
This step varies based on the downloading method selected by each user. In this application project, the
Ancillary file download capability from e? studio is used for demonstration purposes. You can use this
method as a testing tool when developing a customized new image downloader. Application Projects
R11AN0570 and R11AN0576 include image downloader examples using XModem over COM port. They
can be used for reference.

5.4 Customize the Bootloader to other MCUs

When customizing to other MCUs, recreation of the bootloader project is recommended. Changing the board
BSP selection is not a recommended path. Recreating the bootloader project is needed particularly when
moving to a different FSP version.
o Users need to adjust the memory configuration based on the bootloader size and the application size
(refer to).
¢ When customizing to other MCUs using the same FSP version, users can use the stack export and
import functionality to save some steps in the bootloader project recreation.
¢ Note that there can be errors after exporting and importing the stack, user needs to review
the imported stack by comparing with the original bootloader to correct any errors.
To export a stack, right click on the module and select Export and save the stack with .xml as the file
extension.

HAL/Common Stacks % | New Stack > = Extend Stack > % | Remove

~

“# MCUboot
(i) Team >
Resource Configurations > A :

@ MCUboot Port for RA {rm_mcuboot_port) | Validate @ MCUboot logging

of Cut Ctrl+X

=| Copy Ctri+C
@ Paste Ctrl+V @

I ¥ Delete Delete | I

4% MbedTLS (Crypto Only)

Non-secure Callable

mport...

! Add External Memory
Implementation

@ Maodule Resources... ‘
Y
&4 ! _ I 0 Run As >
+ Mbed Crypto H/W % Add Persistent 51
Acceleration on LittleFS (Opti 4% Debug As _ >
(rm_psa_crypto) Compare With >
@ Re{:lace With >
] |
[
4% SCE Compatibility
Mode
@
- v
< >

Figure 78. Export a Stack
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To import a stack, right click in the open area of the Stack window, select Import and choose the
exported .xml file.

Team b

Resource Configurations >
v Validate

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete Delete

MNon-secure Callable

g2y Import.

Export...

Module Resources...

0 Run As >
%% Debug As >
Compare With >
Replace With >

Figure 79. Import a Stack
6. Appendix

6.1 Making the Bootloader for Cortex-M33 Immutable

To make the bootloader immutable, you must lock the flash blocks containing the bootloader from being
programmed and erased.

The RABM4 features two sets of registers which facilitate flash block locking. Block Protect Setting (BPS)
Registers feature bits that map to individual flash blocks. When a bit is set to zero, the corresponding flash
block cannot be erased or programmed. The Permanent Block Protect Setting (PBPS) Registers have a
similar bit mapping to flash blocks. When a bit is set in one of these registers, the corresponding flash block
is permanently locked from being erased and programmed if the same bit in the Block Protect Setting
Register is also cleared to zero. This process is irreversible. Once a flash block is permanently locked, it
cannot be unlocked again.

Based on the example bootloaders provided in this application project, the flash blocks used by the
bootloader are:

¢ RA6M4 Overwrite Mode: block 0-7
e RA6M4 Swap Mode: block 0-8
¢ RAB6MS3 Overwrite Mode: block 0-7

Refer to the Renesas RA Family MCU Securing Data at Rest Using the Arm® TrustZone® Application Project
to understand the operational flow of setting up the Flash Block Protection.

Note that ticking the BSP0 and PBPSO0 Flash Block settings will permanently lock the flash blocks. This
CANNOT be reversed. Further details can be found in sections 6.2.6 and 6.2.7 of the RA6M4 Hardware
User's Manual.

6.2 Making the Bootloader for Cortex-M4 Immutable

Refer to the Renesas RA MCU Family Securing Data at Rest Utilizing the Renesas Security MPU application
project section Permanent Locking of the Flash Access Window (FAW) Region to understand how to make
the bootloader for Cortex-M4 Immutable. Section PC Application to Permanently Lock the FAW in the same
application note describes how to handle Flash locking in production mode.
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6.3 Device Lifecycle Management for Renesas RA Cortex-M33 MCUs

Once the bootloader development is finished, you may want to transition the Device Lifecycle State of the RA
Cortex-M33 MCU to lock down the debugger and the serial programming interface.

We recommend referring to the Device Lifecycle State Transitions in the Production Flow section in the
Renesas RA Family Device Lifecycle Management Key Injection Application Note to understand the device
lifecycle management options during production.

The operational overview of how to use Renesas Flash Programmer to perform these transitions are
explained in the Overview of Device Lifecycle State Transitions using Renesas Flash Programmer section.

6.4 Device Lifecycle Management for Renesas RA Cortex-M4 MCUs

Once the bootloader development is finished, you may want to set up the ID Code protection on the
Renesas RA Cortex-M4 MCU to lock down the debugger and the serial programming interface.

You can refer to the Securing Data at Rest Utilizing the Renesas Security MPU Application Project section
Setting up the Security Control for Debugging for the desired setting to control the device lifecycle
management of the RA Cortex-M4 MCUs using the ID Code protection method.

N

References

Renesas RA Family Securing Data at Rest Utilizing the Renesas Security MPU (R11AN0416)
Renesas RA Family Securing Data at Rest Using the Arm® TrustZone® (R11AN0468)

Renesas RA Family Device Lifecycle Management Key Installation (R11AN0469)

Renesas RA Family Security Design with Arm® TrustZone®- IP Protection (R11AN0467)

Renesas RA Family Secure Bootloader for RA2 MCU Series (R11ANQ0516)

Renesas RA Family Booting Encrypted Image using MCUboot and QSPI (R11AN0567)

Renesas RA Family RA6 MCU Advanced Secure Bootloader Design using MCUboot and Code Flash
Dualbank Mode (R11AN0570)

8. Website and Support

Visit the following URLSs to learn about the RA family of microcontrollers, download tools and documentation,
and get support.

EK-RA6M4 Resources renesas.com/ra/ek-rabm4
EK-RA6M3 Resources renesas.com/ra/ek-rabm3
RA Product Information renesas.com/ra
Flexible Software Package (FSP) renesas.com/ra/fsp
RA Product Support Forum renesas.com/ra/forum
Renesas Support renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a
system-evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)
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TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
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Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

© 2024 Renesas Electronics Corporation. All rights reserved.


https://www.renesas.com/
https://www.renesas.com/contact/

	1.  Overview of MCUboot
	1.1 History of MCUboot
	1.2 MCUboot Functionalities Overview
	1.2.1 Validate Application before Booting and Updating
	1.2.2 Applications Update Strategies


	2. Architecting an Application with MCUboot Module using FSP
	2.1 MCU Memory Configuration using MCUboot Module with FSP
	2.2 Overview of FSP MCUboot Module
	2.2.1 General Configuration
	2.2.2 Application Image Signature Type Options
	2.2.3 Signing Options
	2.2.4 MCU Memory Configuration

	2.3 Designing Bootloader and the Initial Primary Application Overview
	2.4 General Guidelines using the MCUboot Module Across RA Family MCUs
	2.5 Customize the Bootloader
	2.6 Production Support
	2.6.1 Key Provisioning
	2.6.2 Make the Bootloader Immutable for Enhanced Security
	2.6.3 Advance the Device Lifecycle States Prior to the Deploying the Product to the Field


	3. Running the Example Projects
	3.1 Set Up the Hardware
	3.1.1 Set up EK-RA6M4

	3.2 Configure the Python Signing Environment
	3.3 Running the EK-RA6M4 Overwrite Update Mode Example
	3.3.1 Initialize the RA6M4 MCU
	3.3.2 Import the Projects under \ra6m4_overwrite_with_bootloader_tz
	3.3.3 Compile All the Projects
	3.3.4 Debug the Applications and Boot the Primary Applications
	3.3.5 Open the J-Link RTT Viewer
	3.3.6 Downloading and Running the Secondary Applications
	3.3.7 Update the Non-Secure Secondary Image

	3.4 Running the EK-RA6M4 Swap Update Mode Example without Test Mode
	3.4.1 Downloading and Running the Secondary Applications

	3.5 Running the EK-RA6M4 DXIP Update Mode Example
	3.5.1 Downloading and Running the Secondary Applications

	3.6 Set up EK-RA6M3
	3.7 Running the EK-RA6M3 Overwrite Update Mode Example
	3.7.1 Import the Projects under Folder \ra6m3_overwrite_with_bootloader to a Workspace
	3.7.2 Compile the Projects
	3.7.3 Debug the Applications and Boot the Primary Application
	3.7.4 Open the J-Link RTT Viewer
	3.7.5 Downloading and Running the Secondary Applications

	3.8 Running the EK-RA6M3 Swap Test Update Mode Example with Test Mode
	3.8.1 Import the Projects
	3.8.2 Compile the Projects
	3.8.3 Debug the Applications and Boot the Primary Application
	3.8.4 Open the J-Link RTT Viewer
	3.8.5 Downloading and Running the Secondary Applications

	3.9 Troubleshooting

	4. Creating the Bootloader
	4.1 Creating a Bootloader Project for RA Family
	4.1.1 Start Bootloader Project Creation with e2 studio
	4.1.2 Resolve the Configurator Dependencies
	4.1.3 Setting up the Booting Authentication Support
	4.1.4 Setting up the Application Authentication Signature Type
	4.1.5   Add MCUboot Initialization Code


	5. Using the Bootloader with Applications
	5.1.1 Import the Standalone Application Projects
	5.1.2 Configure the Application Projects to Use the Bootloader
	5.2 Signing the Existing Application Projects to Use the Bootloader
	5.2.1 Click Generate Project Content and Compile All Four Application Projects
	5.2.2 Configure the Debug Configuration

	5.3 Mastering and Delivering a New Application
	5.4 Customize the Bootloader to other MCUs

	6. Appendix
	6.1 Making the Bootloader for Cortex-M33 Immutable
	6.2 Making the Bootloader for Cortex-M4 Immutable
	6.3 Device Lifecycle Management for Renesas RA Cortex-M33 MCUs
	6.4 Device Lifecycle Management for Renesas RA Cortex-M4 MCUs

	7. References
	8. Website and Support
	Revision History

